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Welcome to ProSeries® Basic Edition tax software
ProSeries Basic Edition is an easy-to-use, professional-strength tax program that 
includes everything you need to prepare federal and state individual returns. The 
ProSeries Basic Edition program:

l Helps you prepare 1040 returns using a step-by-step process

l Provides checklists that prompt you to ask clients the right questions

l Provides one-click access to form instructions and tax-scenario guidance

l Contains comprehensive error-checking diagnostics

l Lets you e-file your clients’ returns

l Delivers professional-looking printed output

l Offers in-product support when you need it

l Includes extended hours of toll-free phone support during tax season

For information about this topic

Computer system requirements and recommendations

Getting ready for the tax season

Installing ProSeries Basic Edition software

Setting up the ProSeries Basic Edition program

Transferring data from last year’s ProSeries client file

Product licensing

Keeping your tax products up-to-date

Preparing your clients’ returns

Getting information and help

Electronic filing

Bank Products
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Computer system requirements
Make sure the computer on which you intend to use ProSeries Basic Edition software 
meets or exceeds the minimum requirements for all relevant components. If you want 
to use a plug-in utility named Get System Info to get information about your system, 
go to http://web.intuit.com/support/sysinfo, then follow the instructions.

The minimum requirements shown below should provide adequate performance on 
most computer configurations. Systems that don’t meet the minimum requirements 
may not operate as designed. For more information about how system requirements 
can affect the operation of ProSeries Basic Edition software, go to http://
www.proseries.com, select Products, then select either Basic or Professional, and 
finally select the System Requirements tab.

Component Recommendation Minimum Requirement

Computer 2.0 GHz or faster 1.0 GHz

Memory 1 GB RAM or more. More memory 
normally results in improved 
performance.

512 MB RAM. More memory may 
be required if you install many 
products and have a large number of 
clients.

For Windows Vista operating 
systems, we recommend at least 1 
GB RAM.

The ProSeries Basic 
Edition Prepare 
Returns window 
and the start of the 
Federal Information 
Worksheet are 
shown in this 
illustration.

The Refund or 
Amount Due button 
shows the refund 
amount or the 
amount due for the 
open return 
according to the data 
that’s been entered 
thus far.

Client data hasn’t 
been entered in this 
example, so the 
amount shown is $0.
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Getting ready for the tax season
Know your responsibilities. You and your clients are responsible for correctly 
reporting all information that is required by the Internal Revenue Service or 
applicable state taxing agency, and for the accuracy of each return that you file.

Be familiar with your computer system. If you’re unfamiliar with the basic 
operation of your computer or your Microsoft Windows operating system, read the 
owner’s guide for your computer or Windows help.

Hard disk 
space

2 GB or more, depending on the 
number of products you install and 
the number of clients you have.

850 MB. More space may be 
required if you install many 
products and have a large number of 
clients.

Windows 
operating 
system

One of the following:

• Windows XP  - Professional 
edition (service pack 3 or later)

• Windows Vista - Business 
edition, (service pack 1 or later)

One of the following:

• Windows XP - Home or Media 
edition (service pack 3 or later)

• Windows Vista - Home Basic, 
Home Premium, or Ultimate 
edition, (service pack 1 or later)

Screen 
resolution

1024 x 768 or higher 1024 x 768

Printer Hewlett-Packard LaserJet or PCL 
(Printer Control Language) 
compatible printer with 2 MB of 
printer memory

Note: Inkjet printers are not 
recommended.

Hewlett-Packard LaserJet or PCL 
(Printer Control Language) 
compatible printer with 2 MB of 
printer memory.

Note: GDI printers are not 
supported.

CD drive 24X or faster 12X or faster

Internet 
connection

High-speed Internet connection, 
such as T-1, DSL, or cable modem

56.6 K modem

Internet 
Browser

Microsoft Internet Explorer 6.0 or later.

Note: Internet Explorer 6.0 is installed if Internet Explorer 6.0 or later isn’t 
already installed.

Internet 
Service 
Provider (ISP)

None required, but an ISP is required for features that use the Internet, 
such as electronic filing and the online delivery of ProSeries Basic Edition 
products and product updates.

ProSeries Basic Edition software works with most ISPs. Contact your ISP 
if you have a specific question.

Component Recommendation Minimum Requirement
3



basic_eug09.book  Page 4  Monday, October 19, 2009  11:37 AM
Understand the ProSeries Basic Edition License Agreement. The ProSeries Basic 
Edition License Agreement appears at the start of the installation procedure. After the 
software has been installed, you can review the ProSeries Basic Edition License 
Agreement by selecting License Agreement in the Help Center.

Please note the following conditions of the ProSeries Basic Edition License 
Agreement:

l You are licensing the software for use by a named entity and its employees at one 
identified location.

l You are representing to Intuit® that the firm name and address you provide is the 
primary firm name and location used in the normal course of business.

• This is the name and address under which you market yourself and your 
professional services.

• This firm name and address will appear in the “Paid Preparer” designation on 
tax returns.

l You may enter information about multiple preparers, provided that they all are 
employees of the firm listed at that particular address.

Preparing for electronic filing

Electronic Filing Identification Number (EFIN). You must have an IRS-issued 
Electronic Filing Identification Number (EFIN) if you want to file your clients’ 
federal returns (or extension request forms) electronically. In addition, you must be 
able to connect to the Internet from the computer on which you install the ProSeries 
Basic Edition program.

Applying for an EFIN

If you are new to electronic filing or no longer have a valid EFIN, you can apply for 
one using either of the following methods:

l Online. To use the IRS e-file application, go to http://www.irs.gov, click the IRS 
e-file logo, click on the e-services link in the e-file for Tax Professionals 
section, then follow the instructions on the screen.

l Form 8633. Submit Form 8633, Application to Participate in the IRS e-file 
Program.

Important: Multiple preparers who operate as separate and distinct firms—
even if they share office space—are considered to be unique and 
each preparer must purchase a license for his or her own copy of 
ProSeries Basic Edition software.
4 ProSeries Basic Edition Quick Reference Guide 2009
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You can find information about electronic filing at http://www.proseries.com. Select 
Products, then E-File Resources at the bottom of the page. If you have additional 
questions about electronic filing, call the IRS e-help desk at 1-866-255-0654.

State enrollment requirements

Some states require additional electronic filing enrollment paperwork. Verify the 
electronic filing enrollment requirements for each state where you plan to file returns 
electronically.

For more information about electronic filing, see Filing returns electronically on page 
77.

Preparing to offer bank products

When you file your clients’ individual returns electronically, they can receive 
proceeds based on their expected federal refunds in the form of Refund Anticipation 
Loans (RALs), Refund Anticipation Loan Direct Deposits (RALDDs), Refund 
Transfers (RTs), and Refund Transfer Direct Deposits (RTDDs). In addition, your fees 
can be deducted from the client’s refund and deposited into your bank account 
electronically.

Before you can offer bank products to your clients, you must first apply to either 
Santa Barbara Bank & Trust or Refund Advantage to participate in their banking 
products program. For more information about bank products, see Overview of Bank 
Products on page 90.

Important: You must use the version of Form 8633 dated July 2003. If you 
submit an earlier version, the IRS will reject your application. The 
IRS recommends that you submit your application at least 45 days 
prior to the date that you intend to begin filing returns 
electronically. You can find Form 8633 and information about 
electronic filing at the IRS Web site, which is http://www.irs.gov.

Tip: The IRS strongly recommends that you use the Online method to 
apply for an EFIN.

Tip: Under certain circumstances, you can offer a client an RT or 
RTDD based on the expected refund from a state return.
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Ordering presentation folders and envelopes

To purchase presentation folders and window envelopes, call Professional Tax 
Products at 1-888-236-8137, or go to the Professional Tax Products Web site at http://
www.proseriessupplies.com.

Preparing to use your ProSeries Basic Edition products

After you install the software, the ProSeries Basic Edition program performs product 
licensing, which licenses the software that you ordered to your firm. (For more 
information, see Setting up the ProSeries Basic Edition program on page 19 and 
Product licensing on page 31.)

Product licensing information

Product licensing identifies the ProSeries Basic Edition software that’s available to 
you and defines the limits on your use of your ProSeries Basic Edition software.

To see product licensing information before you install ProSeries Basic Edition 
software:

l Review the information on the packing slip that accompanied the ProSeries Basic 
Edition CD, or

l Go to http://www.proseries.com, then navigate to the My ProSeries area

To see product licensing information after you install ProSeries Basic Edition 
software:

l Go to the Information menu and select Product Licenses

Preparing federal returns

When you ordered ProSeries Basic Edition software, you chose one of the following 
ways to prepare federal returns:

l No limit to the number of federal returns. 

l Limit of 50 federal returns. If you need to prepare more than 50 federal returns, 
prepare the “additional” returns on a pay-per-return basis.

Preparing state returns

You also chose one of these options for preparing state returns:

Tip: Prepare federal returns on a pay-per-return basis. You can 
prepare federal returns for $18 per return if you licensed the 50-
return option, and you need to prepare more than 50 federal 
returns.
6 ProSeries Basic Edition Quick Reference Guide 2009
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l No limit to the number of returns for four states. If you licensed the four-state 
option, you can prepare an unlimited number of state returns using the four state 
products that you selected for licensing.

l No limit to the number of returns for two states. If you licensed the two-state 
option, you can prepare an unlimited number of state returns using the two state 
products that you selected for licensing.

l Limit of 50 returns for two states. If you licensed the 50-return option, you can 
prepare up to 50 state returns using the two state products that you selected for 
licensing. If you need to prepare more than 50 state returns, prepare the 
“additional” returns on a pay-per-return basis.

l You licensed the two-state option or the four-state option, and you need to 
prepare returns for other states.

l You licensed the 50-returns for two states option, and you need to prepare more 
than 50 state returns for those states.

l You licensed the 50-returns for two states option, and you need to prepare state 
returns for other states.

For more information about using the pay-per-return system, see Using ProSeries 
Basic Edition products on a pay-per-return basis on page 8.

Electronic filing

If you ordered ProSeries Basic Edition electronic filing capability, all of the following 
apply to your use of ProSeries Basic Edition software to file federal and state returns 
electronically:

l Limit of 100 federal returns and the associated state returns. You can 
electronically file up to 100 federal returns and all state returns that are associated 
with those federal returns.

l File more than 100 federal returns electronically. If you need to electronically 
file more than 100 federal returns (and the state returns that are associated with 
those federal returns), file the “additional” returns on a pay-per-return basis.

For more information about using the pay-per-return system, see Using ProSeries 
Basic Edition products on a pay-per-return basis on page 8.

Tip: Prepare state returns on a pay-per-return basis. You can 
prepare state returns for $14 per return under any of the following 
circumstances:

Tip: File additional federal and state returns on a pay-per-return 
basis. You can electronically file federal returns for $3 per return 
and state returns for $2 per return using the pay-per-return system.
7
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Monitoring your 50-return or 100-return usage

If you licensed a 50-return preparation option or a 100-return electronic filing option, 
here’s how you can check the status of your use of ProSeries Basic Edition software.

l Go to the Information menu and select Return Usage & State License Status

Keeping your product licensing information up-to-date

You’ll need to update your product licensing information under the following 
circumstances:

l Before you begin to prepare client returns, you upgrade your ProSeries Basic 
Edition license. Before you begin to prepare client returns, you can upgrade 
your license:

• From the Basic 50 Returns package to the Basic Unlimited Returns package 
or the Basic Unlimited Returns-100 e-File package, or

• From the Basic Unlimited Returns package to the Basic Unlimited Returns-
100 e-File package

l The ProSeries Basic Edition software or a ProSeries Basic Edition representative 
instructs you to update your product license information

If either of these situations occur, you’ll need to update the product information for 
your firm. To do so, go to the Tools menu, select License Products, then select 
Online (Recommended) or Manual. For more information, see Updating your firm’s 
product licensing information on page 33.

Using ProSeries Basic Edition products on a pay-per-return basis

When you use ProSeries Basic Edition software on a pay-per-return basis, you might 
need to:

Add funds to your pay-per-return account balance. Go to the Tools menu, select 
Pay Per Return, then select Increase account balance.

In the Increase Account Balance dialog box, select Online or Manual, click OK, 
then follow the instructions on the screen.

Tip: The program informs you when only five returns remain until you 
reach a 50-return preparation limit or a 100-return electronic filing 
limit.
8 ProSeries Basic Edition Quick Reference Guide 2009
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Authorize payment for pay-per-return processing. If you prepare federal or state 
returns on a pay-per-return basis, you must authorize the applicable payment for each 
return before you can print it. If you electronically file federal or state returns on a 
pay-per-return basis, you must authorize the applicable payment for each return 
before you can file it electronically.

Check the balance of your pay-per-return account. Go to the Tools menu, select 
Pay Per Return, then select Show account balance.

Increase the balance of your pay-per-return account. Go to the Tools menu, select 
Pay Per Return, select Increase account balance, select Online or Manual, click 
OK, then follow the instructions on the screen.

View or print the Pay-Per-Return audit report. Go to the Tools menu, select Pay 
Per Return, then select View audit report or Print audit report.

Preparing to provide specific information

You will be prompted for information about the following topics while you’re setting 
up your ProSeries Basic Edition program. (You can enter this information later as you 
use the ProSeries Basic Edition program, if you prefer.)

Getting your computer system ready
We suggest that you review the following information before installing ProSeries 
Basic Edition software.

Internet connectivity

Having an Internet connection is necessary to take advantage of ProSeries Basic 
Edition features such as online delivery of tax products and tax product updates, 
product licensing, electronic filing software, bank products software, and the http://
www.proseries.com Web sites.

For this topic... You should know this...

Firm and 
Preparers

Basic information about your firm and the preparers who will be using 
the ProSeries Basic Edition software

Electronic Filing Information about the person(s) who will be the electronic filing 
contact(s) for your firm (if you’re going to offer electronic filing to 
your clients)

Bank Products Your bank products registration information, including information 
about the bank account where your fees will be deposited by Santa 
Barbara Bank & Trust (if you’re going to offer bank products to your 
clients through Santa Barbara Bank & Trust)
9
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Computer performance

We strongly recommend that you do the following for each computer that will run 
ProSeries Basic Edition software:

l Install the latest updates for your operating system from http://
www.microsoft.com.

l Use virus-protection software to check for viruses on the hard drive, and use 
anti-spyware software to check for spyware on the hard drive. Make sure the 
latest software updates are installed.

l Install a firewall (software or hardware) to prevent unauthorized access to your 
computer from the Internet.

l Run the Scan Disk and Disk Defragmenter system tools to correct any errors on 
the hard drive and speed up access to the contents of the hard drive. (For more 
information, refer to Windows Help.)

Last year’s TurboTax data files

If you want to move relevant data from last year’s TurboTax® data files to last year’s 
ProSeries Basic Edition client files, do the following:

1 Make sure you know the location of last year’s TurboTax data files.

2 If you used ProSeries Basic Edition or ProSeries software to prepare last year’s 
returns, proceed to step 4.

If you didn’t use ProSeries Basic Edition or ProSeries software to prepare last 
year’s returns, call ProSeries Basic Edition Customer Service at 1-800-374-7317 
and request last year’s ProSeries Basic Edition Archive CD.

3 After you receive last year’s ProSeries Basic Edition Archive CD, insert the CD 
into the appropriate drive to start the ProSeries Basic Edition installation 
procedure. Follow the instructions on the screen. In the Product Selections 
dialog box, be sure to select the appropriate state products.

4 Start last year’s ProSeries Basic Edition (or ProSeries) program.

5 If a dialog box asks “Would you like to transfer last year’s client files?,” select 
Yes. Otherwise, go to the File menu, select Transfer, then select Transfer 
Clients.

6 In Step 1 of the Transfer window, select <last year> TurboTax 1040 to <last 
year> ProSeries 1040.

7 Complete the remaining four steps in the Transfer window to create ProSeries 
client files. Note where those client files are located.

8 In last year’s ProSeries Basic Edition (or ProSeries) program, open each file then 
save it.

Important: The computer on which you will install ProSeries Basic Edition 
software must have a valid Internet connection.
10 ProSeries Basic Edition Quick Reference Guide 2009
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9 After this year’s ProSeries Basic Edition software has been installed, start the 
ProSeries Basic Edition program if it doesn’t start automatically. When you see 
the dialog box that asks “Would you like to transfer last year’s client files?,” 
select Yes.

10 In Step 1 of the Transfer window, select <last year> Form 1040 to <this year> 
Form 1040.

11 Complete the remaining four steps in the Transfer window to create ProSeries 
Basic Edition client files for this tax year. Information about those client files will 
appear in HomeBase.

Converting last year’s data from non-Intuit tax software data files 
to this year’s ProSeries Basic Edition client files

If you want to move relevant data from last year’s non-Intuit tax software data files to 
this year’s ProSeries Basic Edition client files, do the following:

1 Go to http://www.proseries.com, select New User Program, then select Data 
Conversion to learn about the data conversion services that are available.

2 Call ProSeries Basic Edition Customer Service at 1-800-374-7317 and request 
the conversion packet that’s right for you.

3 After you receive the conversion packet, follow the steps in the Conversion 
Checklist.

4 At the conclusion of the conversion process, the converted data will be in last 
year’s ProSeries client files that are stored in C:\YYconv, where YY represents 
that last two digits of the tax year from which the data is converted.

5 After this year’s ProSeries Basic Edition software has been installed, start the 
ProSeries Basic Edition program if it doesn’t start automatically. When you see 
the dialog box that asks “Would you like to transfer last year’s client files?,” 
select Yes.

6 In Step 1 of the Transfer window, select <last year> Form 1040 to <this year> 
Form 1040.

7 In Step 2 of the Transfer window, select C:\YYconv, where YY represents that 
last two digits of the tax year from which the data is converted.

8 Complete the remaining steps in the Transfer window to create new ProSeries 
Basic Edition client files for the current tax year. Information about those client 
files will appear in HomeBase.

Know the location of last year’s ProSeries Basic Edition client files

ProSeries Basic Edition software for this tax year can transfer relevant data from last 
year’s ProSeries Basic Edition (or ProSeries) client files into new ProSeries Basic 
Edition client files for the current tax year. If you have last year’s ProSeries Basic 
Edition (or ProSeries) client files, make sure you know the location of those client 
files—especially if last year’s client files are stored on external storage media.
11
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Know the location of Quicken data files

If you use Quicken® software, make sure you know where the relevant Quicken data 
files are located.

Tip: The default installation location for last year’s ProSeries Basic 
Edition client file directory was C:\BasWinYY\YYData (where 
YY represents the last two digits of the tax year). The default 
installation location for last year’s ProSeries client file directory 
was C:\ProWinYY\YYData (if a stand-alone installation) or 
x:\ProSeries\ProNetYY\YYData (if a network installation) where 
x represent the drive where last year’s ProSeries shared network 
components were installed, and YY represents the last two digits 
of the tax year.
12 ProSeries Basic Edition Quick Reference Guide 2009
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Installing ProSeries Basic Edition software
You install ProSeries Basic Edition software from a ProSeries Basic Edition CD (or 
via the Internet from ProSeries.com). Each ProSeries Basic Edition CD contains the 
latest version of the ProSeries Basic Edition federal (Form 1040) product and each 
ProSeries Basic Edition state product that’s currently available.

When you run the ProSeries Basic Edition installation program, select each ProSeries 
Basic Edition state product that you expect to use for the tax year.

The installation program will install each state product that you selected, provided the 
tax product is on the ProSeries Basic Edition CD. The on-screen version of this 
ProSeries Basic Edition Quick Reference Guide will also be installed.

Before you install ProSeries Basic Edition, note the following important information:

l Release Notes. Read the printed Release Notes and any other material that 
accompanied the ProSeries Basic Edition CD.

THE RELEASE NOTES MAY CONTAIN, AMONG OTHER THINGS, 
ADDITIONAL LICENSING TERMS THAT GOVERN THE USE OF THE 
PROSERIES BASIC EDITION SOFTWARE AND RELATED SERVICES.

l Packing slip. The packing slip that accompanied the ProSeries Basic Edition CD 
contains your Customer Number and ZIP code, which is information that you 
will need to provide for product licensing purposes.

Installing ProSeries Basic Edition software

To install ProSeries Basic Edition software:

1 Close all open applications and turn off any virus-protection utilities on the 
computer.

2 If you’re installing from a ProSeries Basic Edition CD, insert the ProSeries 
Basic Edition CD into the appropriate drive. Don’t remove the CD from the drive 
until you finish installing products.

Tip: The installation program always installs the ProSeries Basic 
Edition federal (Form 1040) product, so you don’t need to select it.

Important: We strongly recommend that you install ProSeries Basic Edition 
software when you receive the ProSeries Basic Edition CD so you 
can receive other products via the Internet as soon as possible. For 
more information, see Keeping your ProSeries Basic Edition tax 
products up-to-date on page 35.
13
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If you’re installing from an .EXE file that you downloaded from 
ProSeries.com, start Windows Explorer, go to C:\Temp, then double-click the 
.EXE file.

3 In the ProSeries Setup Installation dialog box, click Install ProSeries. If the 
ProSeries Basic Edition Installation dialog box appears, go to Step 4.

If you’re installing from a ProSeries Basic Edition CD and the ProSeries Basic 
Edition Installation dialog box doesn’t appear automatically:

a. Go to the Windows taskbar, click Start, then select Run.

b. In the Run dialog box, type x:\CDSETUP (where x represents the letter 
of the drive containing the ProSeries Basic Edition CD), then click OK.

c. In the ProSeries Setup Installation dialog box, click Install 
ProSeries, then continue to Step 4.

4 In the Welcome dialog box, click Next when you’re ready to continue.

5 A System Warning dialog box appears if your computer doesn’t meet the 
minimum system requirements for this year’s ProSeries Basic Edition software. 
(For more information, see Computer system requirements on page 2.)

If the System Warning dialog box appears, read the information, then do one of 
the following:

• Click Cancel to exit the installation program, then correct the situation(s) 
identified in the System Warning dialog box. After your computer meets the 
minimum system requirements for this year’s ProSeries Basic Edition 
software, go back to step 1 and start the installation procedure again.

• Check the box indicating that you understand you may not receive technical 
support for issues that you may encounter while using the ProSeries Basic 
Edition program, then click Next to continue to Step 6.

6 In the Software License Agreement dialog box, read the ProSeries Basic Edition 
License Agreement to understand the scope of your rights to use ProSeries Basic 
Edition software.

• Select I accept the terms of the license agreement if you agree to accept all 
the terms of the ProSeries Basic Edition License Agreement, then click Next 
and continue to Step 7.

• Select I do not accept the terms of the license agreement if you don’t agree 
to accept all the terms of the ProSeries Basic Edition License Agreement, then 
click Cancel and exit the installation program.

Important: We strongly recommend that you click Cancel and correct the 
situation(s) identified in the System Warning dialog box. For 
information about how system requirements can affect the 
operation of the ProSeries Basic Edition program, go to http://
www.proseries.com.
14 ProSeries Basic Edition Quick Reference Guide 2009
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7 In the Select Destination Directory dialog box, do one of the following:

• Click Next if you want to install ProSeries Basic Edition software in a 
\BASWINyy directory on the drive that’s shown in the dialog box. (That drive 
will be C: or the drive on which last year’s ProSeries software was installed. 
“yy” represents the last two digits of the tax year.) Skip to Step 9.

• Click Browse if you want to install ProSeries Basic Edition software to a 
different drive or directory. Continue with Step 8.

8 In the Select Folder dialog box, take the following steps:

a. Select the drive where you want to install ProSeries Basic Edition 
software.

Note that ProSeries Basic Edition software cannot be installed to a 
network drive for shared use.

b. After selecting the drive, type the folder name \BasWinyy (where “yy” 
represents the last two digits in the tax year) in the Folder name field 
so that it appears after the drive you selected, then click OK.

BASWINyy directory. For best results, use BASWINyy as the name of 
the directory for this year’s ProSeries Basic Edition software (where 
“yy” represents the last two digits in the tax year). Be sure you install 
the ProSeries Basic Edition software to a directory, not to the root of a 
drive.

c. When prompted to create the directory in the location that you’ve 
specified, click Yes.

d. When you return to the Select Destination Directory dialog box, click 
Next. Continue with Step 9.

9 In the Product Selections dialog box, select the ProSeries Basic Edition state 
products that you expect to use for the tax year, then click Next.

Important: If for any reason you find the terms of the ProSeries Basic Edition 
License Agreement unacceptable, do not install the software. Call 
ProSeries Basic Edition Customer Service at 1-800-374-7317 for a 
refund instead.

Click here if you want to install your 
ProSeries Basic Edition products on a drive 
other than the drive that’s shown in the 
Destination Folder field.

See Step 8 for additional instructions.
15



basic_eug09.book  Page 16  Monday, October 19, 2009  11:37 AM
Every ProSeries Basic Edition state tax product for is shown in this dialog box, 
including products that may not be available on the ProSeries Basic Edition Tax 
Release 1 CD.

If you ordered specific state products when you placed your order, be sure to 
select those state products in this dialog box. If you select any state products other 
than the products that you chose, they will be installed for pay-per-return use. For 
information about pay-per-return use, see Using ProSeries Basic Edition products 
on a pay-per-return basis on page 8.

You can install additional products later, as described in Keeping your ProSeries 
Basic Edition tax products up-to-date on page 35.

10 If any of the state products you selected aren’t on the CD, you’ll see the 
Installation Note dialog box. Review the list of products that will be installed 
later (when they become available), then click OK.

11 In the Installation Details dialog box, review all the information, including the 
Required Space and Available Space information, then click Next.

The installation program installs all available ProSeries Basic Edition tax 
products that you selected. Continue with Step 12.

Installation Failed dialog box. If you see this dialog box, a product was not 
installed properly. Click Help to find a possible solution, then click Exit to exit 
the installation program.

12 Additional components. Wait while additional components, such as any 
necessary fonts, Internet Client software, the ProSeries Basic Edition Quick 
Reference Guide, a search engine, a PDF print driver, and ProSeries Basic 

Tip: If you used ProSeries software for the previous tax year, the state 
products that were installed last year may already be selected.
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Edition Product Licensing components are installed. Dialog boxes and progress 
bars keep you informed.

13 Internet Explorer. If Microsoft Internet Explorer 6.0 or later isn’t installed on 
your computer, the installation program installs Internet Explorer 6.0 before 
continuing. ProSeries Basic Edition software requires portions of Internet 
Explorer 6.0 or later to run properly.

14 Restart Windows message. Restart your computer if you are prompted to do so.

Tip: If the installation program doesn’t resume after you restart the computer, 
start the ProSeries Basic Edition program by double-clicking the ProSeries 
Basic Edition shortcut icon on your Windows desktop. The Connected Customer 
Wizard will begin automatically. Skip Step 15 through Step 18 and proceed to 

Setting up the ProSeries Basic Edition program on page 19 now.  

15 Setup Complete. In the Setup Complete dialog box, click Finish, then continue 
with Step 16.

We recommend that you leave the check mark in the Launch ProSeries Basic 
Edition option.

16 If the Launch ProSeries Basic Edition option was selected: The Connected 
Customer Wizard begins automatically. Proceed to Setting up the ProSeries Basic 
Edition program on page 19.

If the Launch ProSeries Basic Edition option wasn’t selected: You return to 
the ProSeries Basic Edition Installation dialog box. Click Exit to return to the 
Windows desktop. Continue with Step 17.

Important: If the installation program installs Microsoft Internet Explorer, you 
are prompted to restart your computer. After the computer restarts, 
the installation program will finish the ProSeries Basic Edition 
installation procedure.
17



basic_eug09.book  Page 18  Monday, October 19, 2009  11:37 AM
17 After you return to the Windows desktop, start the ProSeries Basic Edition 
program by double-clicking the ProSeries Basic Edition shortcut icon. The 

Connected Customer Wizard will begin automatically.  

18 Continue with Setting up the ProSeries Basic Edition program on page 19.

Troubleshooting suggestions

If you have difficulty installing or starting the ProSeries Basic Edition program, see 
the troubleshooting suggestions in the following table.

If this occurs... Do this...

A dialog box informs 
you there was an error 
during the installation 
process

1. Write down the error message, then restart the computer.

2. Go to the Start menu, point to Programs, then Accessories, 
then System Tools, and then click ScanDisk.

3. After ScanDisk is complete, go to the Start menu, point to 
Programs, then Accessories, then System Tools, and then click 
Disk Defragmenter.

4. After Disk Defragmenter is finished, run your virus-protection 
software.

5. Clean the ProSeries Basic Edition CD with a soft cloth, then try 
to install the ProSeries Basic Edition software again.

A dialog box informs 
you that your 
computer doesn’t 
have enough disk 
space

1. Go to the Start menu, point to Programs, then Accessories, 
then System Tools, and then click Disk Cleanup.

2. Try to install the ProSeries Basic Edition software again.

3. If there still isn’t enough disk space, remove unused programs 
or data from the hard drive.

The ProSeries Basic 
Edition program 
doesn’t start when it 
should

1. Restart the computer.

2. Make sure no other applications are running.

3. Double-click the ProSeries Basic Edition icon on the desktop.

You still are unable to 
install or start the 
ProSeries Basic 
Edition program

Start your Internet browser, then go to http://www.proseries.com to 
see additional troubleshooting solutions.

You are unable to 
resolve the problem

Call ProSeries Basic Edition Technical Support by phone, e-mail, 
or chat.

Refer to http://www.proseries.com/support for contact information 
and hours of operation. To save time, gather as much information 
as possible, including any error messages.
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Setting up the ProSeries Basic Edition program
The first time that you start the ProSeries Basic Edition program, the Connected 
Customer Wizard helps you set up the program if there’s a valid Internet connection.

If the computer has a valid Internet connection

If the computer has a valid Internet connection, the Connected Customer Wizard 
performs the following important tasks to save you time:

l Internet Connection. Connects via the Internet to an Intuit ProSeries Basic 
Edition server that contains customer information.

l Firm information. Retrieves the name and address of your firm from the Intuit 
ProSeries Basic Edition server.

l Product licensing. Licenses your ProSeries Basic Edition tax software to your 
firm, based on your Customer Number, ZIP code, and information in the 
customer database on the Intuit ProSeries Basic Edition server.

• Products with no usage limitations are licensed as Unlimited.

• Products with a 50-return preparation limit are licensed as 50 Return Limit.

• Products with a 100-return electronic filing limit are licensed as 100 Return 
Limit.

• All other products are licensed as Pay-Per-Return.

For more information, see Product licensing on page 31.

l Product updates. Checks for updates to the products that were installed from the 
ProSeries Basic Edition CD, then downloads and applies the relevant updates, if 
any.

l New products. Checks for products that you selected for installation that weren’t 
installed from the ProSeries Basic Edition CD, then downloads and installs those 
products, if any.

Proceed to Using the Connected Customer Wizard below.

If the computer doesn’t have a valid Internet connection

If the computer doesn’t have a valid Internet connection, you see a dialog box that 
explains the benefits of being connected and asks whether you want to start the 
Internet Connection Setup Wizard.

l If you think you might be able to establish a valid Internet connection, click Yes 
to run the Internet Connection Setup Wizard. After you establish a valid Internet 

Tip: If you need to edit information that the Connected Customer 
Wizard retrieves from the Intuit ProSeries Basic Edition server, 
you can do that later in the ProSeries Basic Edition program.
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connection and return to the Connected Customer Wizard, proceed to Using the 
Connected Customer Wizard below.

l If you know you won’t be able to establish a valid Internet connection now, click 
No to exit the Connected Customer Wizard. The ProSeries Basic Edition program 
will start and the Options Setup Wizard will begin. Proceed to Setting ProSeries 
Basic Edition options on page 22.

Tip: To establish a valid Internet connection at a later time, go to the ProSeries 
Basic Edition Help menu and select Internet Connection Setup.

Using the Connected Customer Wizard

When the Connected Customer Wizard starts, go to:

l Step 1 if the computer has a dial-up Internet connection

l Step 2 if the computer has a non-dial-up Internet connection

1 If the computer has a dial-up Internet connection, you are prompted to 
connect to the Internet if the computer isn’t currently connected.

After you connect to the Internet, continue with Step 2.

2 In the Connected Customer dialog box, click Choose Products to Install if you 
want to view the ProSeries Basic Edition products that you selected to install, or 
if you want to select additional ProSeries Basic Edition products for installation.

Click Next in the Connected Customer dialog box when you’re ready to 
continue to Step 3.

3 The Customer Information dialog box opens so you can enter or verify your 
Customer Number and ZIP code. That information is printed in the Sold To: area 
in the upper-left corner of your ProSeries Basic Edition packing slip.

Important: Your computer must have an Internet connection so you can 
receive ProSeries Basic Edition products and product updates after 
you install the software from a ProSeries Basic Edition Tax CD (or 
an .EXE file that you downloaded from ProSeries.com).

Click here to review the state products 
that are selected for installation or to 
select additional state products for 
installation.

Click here when you’re ready to continue.
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4 Click Next after you enter your Customer Number and ZIP code. A Progress 
dialog box keeps you informed about what the Connected Customer Wizard is 
doing.

The Connected Customer Wizard adds a check when it successfully completes a 
task. If the wizard is unable to complete a task, you’ll see an “X” instead.

5 Click Next after the Connected Customer Wizard finishes the setup tasks.

6 In the Verify Firm Information dialog box, review the information carefully. 
This is the information that we have on file for your firm (based on the Customer 
Number and ZIP code entered). The program prints this information on all 
returns prepared by your firm.

7 Select Yes or No, then click Next.

• If you selected Yes, skip to Step 11.

• If you selected No, you see the Enter Firm Information dialog box. Continue 
with Step 8.

8 Enter or edit your firm’s name and address, then click Next.

The numbers you enter in these fields 
should match the Customer Number and 
ZIP code that are printed in the Sold To: 
area of your packing slip.

A different Customer Number and ZIP 
code might appear in the Ship To: area of 
your packing slip.

Click Yes if your firm information is 
correct.

Click No if you want to enter or edit your 
firm information.
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9 If you make significant changes to your firm’s name or address, the Connected 
Customer Wizard transmits the updated information to an Intuit server via the 
Internet, or you see a dialog box that instructs you to call Customer Service to 
update your firm information in our records. Click OK to continue.

10 Review the firm and product information in the Product Licenses dialog box.

11 If there are new products or product updates to download, wait while the 
ProSeries Update program downloads and installs those new products and 
product updates. When the results of that process appear in the ProSeries Basic 
Edition Update dialog box, review the status of each product that you selected 
for installation.

• Click Details to see more information.

• Click Print to print the information.

• Click “Read the latest Critical Product Information” to see the most recent 
ProSeries support newsletter in a browser window.

When you’re ready to continue, click Close.

12 When the Connected Customer Wizard finishes, the Prior Year Settings 
Transferred dialog box opens or the Options Setup Wizard begins so you can set 
up various ProSeries Basic Edition options. Proceed to Setting ProSeries Basic 
Edition options next.

Setting ProSeries Basic Edition options
The first time this year's ProSeries Basic Edition program starts, it transfers 
preferences and settings that you used with last year’s ProSeries program if it locates 
the file with that option information on your system. Of course, if you didn’t use a 
ProSeries program last year, this year’s program won’t be able to locate a file with last 
year’s ProSeries preferences and settings.

l Not Transferred. If the program wasn’t able to transfer last year’s ProSeries 
preferences and settings, the Options Setup Wizard starts. Proceed to the next 
section, Using the Options Setup Wizard.
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l Transferred. If the program transferred last year’s ProSeries preferences and 
settings, the Prior Year Settings Transferred dialog box opens.

If you see the Prior Year Settings Transferred dialog box, review the information, 
then click OK.

l If electronic filing information was transferred, the Options Setup Wizard starts. 
Proceed to the next section, Using the Options Setup Wizard.

l If electronic filing information wasn’t transferred, a dialog box asks “Do you 
plan to offer Electronic Filing of returns/extensions as part of your tax 
preparation practice?”

• If you answer Yes, the Options Setup Wizard starts. Continue with the next 
section, Using the Options Setup Wizard.

• If you answer No, the Options Setup Wizard doesn’t start. Proceed to 
Transferring data from last year’s ProSeries client files on page 27.

Using the Options Setup Wizard

The Options Setup Wizard helps you set ProSeries Basic Edition options that you 
need to set before you complete returns. The wizard starts automatically under the 
circumstances explained in the previous section. If you want to start the Options 
Setup Wizard later, go to the Help menu and select Options Setup Wizard.

When you finish with each Options Setup Wizard dialog box, click Next.

Most Options Setup Wizard dialog boxes are self-explanatory. The following table 
briefly describes the Options Setup Wizard dialog boxes that you might see.

Name of dialog box Comments

Firm/Preparer 
Information

See Entering firm and preparer information below.

Filing Client Returns 
Electronically

Answer either:

• Yes, some returns may be filed electronically

• No, returns will not be filed electronically

E-File Electronic 
Signature PIN

If you see this dialog box, answer either:

• Yes, automatically generate taxpayer PINs

• No, don’t automatically generate taxpayer PINs

Check for EF 
Acknowledgments

If you see this dialog box, select the frequency (in days) that you 
want to be prompted to check for electronic filing 
acknowledgments.

ProSeries Bank 
Products Software

If you see this dialog box, answer either:

• Yes, ProSeries Bank Products may be offered

• No, ProSeries Bank Products will not be offered
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Entering firm and preparer information

You enter information about your firm in the Firm/Preparer Information dialog 
box. If you completed the Connected Customer Wizard described in Using the 
Connected Customer Wizard, you’ll see your firm’s name and address in the gray area 
of the Firm Information section.

Enter other information about your firm in the fields below the gray area. If the firm 
will be filing returns electronically using the firm’s Electronic Filing Identification 
Number (EFIN) instead of a preparer’s EFIN, be sure to enter the firm’s EFIN and an 
Efile contact name.

Enter information about the firm’s preparers in the Preparer/Electronic Return 
Originator (ERO) Information section of the dialog box. There’s room to enter 
information for many preparers. If preparers will be filing returns electronically, enter 
Electronic Return Originator (ERO) information in this section also. If you enter an 
EFIN for a preparer, be sure to enter an Efile contact name also. If the ProSeries Basic 

Select a Printer If you have more than one printer, select the printer that ProSeries 
Basic Edition will use.

Print a Test Page Click the Print Test Page button to print a test page with 
information including the name of the printer and printer driver.

Check for Product 
Updates

Select the frequency (in days) that you want to be prompted to 
check for product updates.

Congratulations Click Finish to exit the Options Setup Wizard.

Tip: If you don’t see your firm’s name and address, you’ll retrieve that 
information from an Intuit Internet server later, as explained in 
Product licensing on page 31.

Name of dialog box Comments

During the product licensing procedure, your 
firm’s name and address are retrieved from an 
Intuit Internet server, then entered here.

Enter other information about your firm here.

Enter preparer and ERO information in this 
section.

To move to new fields, press ENTER or TAB, 
or use your mouse.
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Edition program transferred preparer information from last year’s program, edit that 
information as necessary.

This table explains some of the fields in the Firm/Preparer Information dialog box:

Tip: For information about any field in the Firm/Preparer 
Information dialog box, right mouse click the field, then select 
About <Field> on the pop-up menu.

Field Explanation

Firm Name 
and Address

This must be the primary firm name and location used by you in the 
normal course of business (in other words, the firm name and address 
under which you market yourself and your professional services). This 
information prints in the Paid Preparer area on each tax return for which 
you are the paid preparer.

You can’t enter or edit your firm’s name or address in the Options Setup 
Wizard.

• To edit information in the shaded area after you finish the Options 
Setup Wizard, go to the Tools menu, select Options, select Firm/
Preparer Info, click the Edit button, then follow the on-screen 
instructions.

• To enter your firm’s name and address after you finish the Options 
Setup Wizard, go to the Tools menu, select License Products, select 
Online or Manual, then follow the on-screen instructions.

Electronic 
Filing 
Identification 
Numbers and 
Efile Contact 
Names

If your firm has an Electronic Filing Identification Number (EFIN), enter 
the firm’s EFIN and an Efile Contact Name in the Firm Information 
section.

If a preparer has an Electronic Filing Identification Number (EFIN), enter 
the firm’s EFIN and an Efile Contact Name in the Preparer/Electronic 
Return Originator (ERO) Information section.

Preparer Code Enter a code of up to three characters to identify the preparer.
For example, enter the preparer's initials or a numeric code.
Each Preparer Code must be unique.

As a preparer prepares returns, he or she enters his or her code in the 
Preparer Code field at the start of Part V-Return Preparer Information 
in the client's Federal Information Worksheet to associate that return with 
that preparer.

Tip: If you prepare a return for which you are not the paid preparer, and 
you want “self-prepared return” or “non-paid preparer” to appear in the 
paid preparer section of applicable forms instead of your company’s firm 
name and address, select the “Self-Prepared” or “Non-Paid Preparer” box 
below the Preparer Code field at the start of Part V-Return Preparer 
Information in the client's Federal Information Worksheet.
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To run the Options Setup Wizard whenever you want from within the ProSeries Basic 
Edition program, go to the Help menu and select Options Setup Wizard.

Selecting the state products you want to license

In the Choose State Licenses dialog box, select the state products that you want to 
license for unlimited use, then click OK. You can select up to two or four state 
products, depending on which ProSeries Basic Edition suite you purchased.

If you prefer to wait, you can license state products later. State products that aren’t 
licensed for unlimited use can be used on a pay-per-return basis.

Print name in 
signature area?

Check this box to print the preparer's name on the Preparer's Signature 
line of the tax return. The preparer can then write his or her signature on 
top of or next to his or her printed name.

Self-employed
?

Select this box if you want the program to check the Self-Employed box 
in the Paid Preparer area of the tax returns.

Checking the Self-employed box does not replace the firm’s name with 
the preparer's name, even if the preparer is self-employed. The firm name 
always prints on the returns that are prepared by the preparer.

ERO 
Practitioner 
PIN

Enter any five digits (except all zeros) that the preparer chooses. The IRS 
requires that tax practitioners use PINs when e-filing individual returns.

Tip: To see detailed information about ProSeries Basic Edition options 
after you finish setting up the program, use the Search Help 
feature on the Help toolbar or in the Help Center. (For information 
about the Search Help feature, see Getting information and help 
on page 71.)

Field Explanation
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Transferring data from last year’s ProSeries client 
files
The transfer procedure is a simple way to start your clients’ ProSeries Basic Edition 
client files for this year using the relevant data stored in their ProSeries Basic Edition 
client files or ProSeries client files from last year.

When you complete the Options Setup Wizard or select OK in the Prior Year 
Settings Transferred dialog box the first time that you start the ProSeries Basic 
Edition program, you are asked if you want to transfer last year’s client files.

If you have last year’s ProSeries Basic Edition client files or ProSeries client files, 
click Yes to go to the Transfer window, then complete the five steps listed on the left 
side of the Transfer window.

Note the following:

l The choices for Step 1, “Select the type of files to transfer” are <last year> Form 
1040 to <this year> Form 1040 and <this year> TurboTax 1040 to <this year> 
ProSeries 1040 because you can transfer data from last year’s ProSeries client 
files or this year’s TurboTax data files.

l The most likely entry for Step 2, “Transfer data files from” is 
C:\BasWinYY\YYData (the default location for last year’s ProSeries Basic 
Edition client files, where YY represents the last two digits of the tax year) or 
C:\ProWinYY\YYData (the default location for last year’s ProSeries client 
files, where YY represents the last two digits of the tax year).

Tip: If you used TurboTax or non-Intuit tax software for the prior tax 
year, the data in last year’s data files can be moved into this year’s 
ProSeries client files.

• If you have TurboTax data files from last year, see Last 
year’s TurboTax data files on page 10.

• If you have non-Intuit tax software data files from last year, 
see Converting last year’s data from non-Intuit tax software 
data files to this year’s ProSeries Basic Edition client files 
on page 11.
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When you click Transfer, the ProSeries Basic Edition program creates a new client 
file for each client whose data is being transferred, then transfers the applicable data 
into the new ProSeries Basic Edition client file for this year.

The Batch Transfer Status dialog box keeps you informed during the Transfer 
process, and the Transfer Log dialog box opens when the ProSeries Basic Edition 
program finishes transferring client data. Review the information, then click Close to 
go to HomeBase. HomeBase is discussed in Using HomeBase on page 38.

Electronic filing. If last year’s return was marked for electronic filing, that selection 
is transferred to this year’s return. PINs are not transferred, although an election to use 
PINs is. If a client’s federal return will be electronically filed using a PIN, open the 
client’s federal return, scroll down the Federal Information Worksheet to Part VI-
Electronic Filing of Tax Return Information, then enter all applicable information.

Important: If your firm will be filing returns electronically from more than 
one computer, and each computer is using the same EFIN, change 
the starting number in the DCN counter in the ProSeries Basic 
Edition program on all but one computer before opening any 
returns. For more information, see If more than one computer will 
be using the same EFIN on page 78.

Tip: For more information about transferring data from last year’s 
ProSeries Basic Edition client files or ProSeries client files, use the 
Search Help feature on the Help toolbar or in the Help Center to 
find the information that you want. (For instructions, see Getting 
information and help on page 71.)

1
Select the type of transfer 
you want to perform from 
the list of alternatives.

2
Select the location of your 
existing client files.

3
Select a location for the 
new client files.

4
Select the client files that 
you want to transfer data 
from, or click the Select 
All button.

5
After you’ve selected one 
or more clients, click 
Transfer.
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Product licensing
Product licensing is a system that licenses your ProSeries Basic Edition tax software 
to your firm. Product licensing is required before you can print returns or file returns 
electronically.

Product licensing uses your Customer Number, ZIP code, and information in Intuit’s 
records to deliver the following to your ProSeries Basic Edition tax software:

l An Unlimited-use license for each ProSeries Basic Edition product that you’ve 
licensed for Unlimited use—even if those products haven’t been installed yet

l A 50-return limit license for each ProSeries Basic Edition product that you’ve 
licensed for the preparation of up to 50 returns—even if those products haven’t 
been installed yet

l A 100-return limit license for ProSeries Basic Edition electronic filing if you’ve 
licensed a ProSeries Basic Edition suite that supports electronic filing of up to 
100 returns

l Your firm’s name and address

Product licensing can be performed using the Online method or the Manual method.

Online product licensing

The Connected Customer Wizard performs product licensing automatically when you 
install ProSeries Basic Edition tax software on a computer that has an Internet 
connection. If you want to initiate Online product licensing, go to the Tools menu, 
select License Products, select Online (Recommended), then click OK.

Be sure to read Updating your firm’s product licensing information on page 33.

Product licensing using the Manual method

If automatic, Online product licensing hasn’t been performed (as explained above), 
you’ll see the message “Product Licensing Required” in the Messages from 
ProSeries Basic area of HomeBase.

Tip: You can make non-significant changes to your firm’s name and 
address (such as changing “Dr.” to “Drive”) after ProSeries Basic 
Edition product licensing has occurred.
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When you click the “Product Licensing Required” message, you see a License 
Products dialog box that includes two options:

l Online (Recommended)

l Manual

Select Manual, then click OK. You’ll see the License Products dialog box that’s 
shown next.

Be sure to read Updating your firm’s product licensing information below.

Tip: The two ways that you can contact Intuit for manual product 
licensing are:

• Automated Touch Tone phone service (call 
1-800-723-0692)

• Talk to a Customer Service representative (call 
1-800-374-7317)

1
Verify your Customer Number and ZIP 
code.

2
Enter your firm’s name and address. 
(This information must match the 
information contained in Intuit’s 
records.)

3
Contact Intuit using one of three 
methods. You will receive a unique 
Activation Code from Intuit.

4
Enter the Activation Code that you 
received from Intuit, then click OK.
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Updating your firm’s product licensing information

Update your firm’s product licensing information under the following circumstances:

l Before you begin to prepare client returns, you upgrade your ProSeries Basic 
Edition license. Before you begin to prepare client returns, you can upgrade 
your license:

• From the Basic 50 Returns package to the Basic Unlimited Returns package 
or the Basic Unlimited Returns-100 e-File package, or

• From the Basic Unlimited Returns package to the Basic Unlimited Returns-
100 e-File package

For more information about using the pay-per-return system, see Using ProSeries 
Basic Edition products on a pay-per-return basis on page 8.

l The ProSeries Basic Edition software or an Intuit ProSeries Basic Edition 
representative instructs you to update your product license information.

If any of these situations occur, go to the Tools menu, select License Products, select 
Online or Manual, then click OK.

l If you chose Online, simply wait for the product licensing procedure to 
conclude.

l If you chose Manual, just follow the instructions in the License Products dialog 
box shown above.

Important: You can upgrade your ProSeries Basic Edition license only if you 
haven’t begun to prepare client returns yet. If you’ve been 
preparing client returns and you discover that you need to prepare 
or e-file more returns than your ProSeries Basic Edition license 
allows, prepare or e-file the “additional” returns on a pay-per-
return basis.
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Keeping your ProSeries Basic Edition tax 
products up-to-date
You can install new products and update previously-installed products via the Internet 
and from any ProSeries Basic Edition Archive CDs that you receive, as explained in 
this section. Getting tax products and updates via the Internet helps you have the most 
up-to-date versions of the ProSeries Basic Edition tax products that you use.

Getting products and product updates via the Internet

After you install ProSeries Basic Edition software, use the Internet to get any 
newly-released products and product updates.

1 Use any of the following methods to start the ProSeries Basic Edition Update 
program:

• In HomeBase, go to the toolbar and click the Update button.

• In HomeBase or an open return, go to the Update menu and select Update 
Installed Products.

• Go to the Windows taskbar, click Start, select Programs, then ProSeries 
Basic Edition, then ProSeries Update.

2 Wait while the ProSeries Update program checks for the product releases and 
product updates that you’re interested in. If the ProSeries Update program 
downloads any files, you can use your computer (including ProSeries Basic 
Edition) while that occurs.

Important: If you want to receive additional ProSeries Basic Edition CDs for 
this tax year after the ProSeries Basic Edition Tax 1 CD, you must 
request that ProSeries Basic Edition CD option and pay a fee.

Important: As soon as a ProSeries Basic Edition tax product or tax product 
update becomes available, it is posted to the ProSeries Basic 
Edition Tax Products Internet server. The products and product 
updates on a ProSeries Basic Edition CD are the same as those that 
are available for download via the Internet days or weeks before 
they are available on a ProSeries Basic Edition CD.

Tip: If you want to review the state products that are selected for 
installation or select additional state products, go to the Update 
menu and select Select and Download New Products to open the 
Product Selections dialog box. When you’re finished, click Next 
to start the ProSeries Update program.
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3 When the ProSeries Update program finishes the update process, you’ll see a 
dialog box that informs you either:

• “No ProSeries updates found...,” or

• “ProSeries has been updated with the following...”

4 Review the list of relevant products to see which are “Current” and which are 
“Updated,” then click Close.

5 If you see the Ready to Install dialog box (because some products are 
“Updated”), click Install Now.

Getting products and updates from the ProSeries Basic 
Edition CDs

To install ProSeries Basic Edition products and updates from a ProSeries Basic 
Edition CDs that you receive during the tax season (if any):

1 Insert the ProSeries Basic Edition CD into your CD drive.

2 Allow the installation program to install the appropriate ProSeries Basic Edition 
tax products and tax product updates from the CD.

3 If you want to review the products that are selected for installation or select 
additional products for installation, click the Select Additional Products button.

4 After you review the products or select additional products for installation, click 
OK.

For information about a specific ProSeries Basic Edition tax product:

l Click the Help button to open the Help Center, select ReadMe Information in 
the Technical Support area, then select a product (such as Form 
1040:Individual).

l Open a return for that tax product, go to the Search Help field on the Help 
toolbar or in the Help Center, type one or more keywords, then press ENTER. 
Review the list of search results in the Help Center. Click the blue, underlined 
title of a search result to see more information.
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Preparing your clients’ returns
Before you begin preparing returns, you need to be familiar with the HomeBase 
window and its associated tools. We suggest that you go through each section below 
in the order specified to get a thorough understanding of the tools provided by 
ProSeries Basic Edition for preparing returns.

When you start the ProSeries program, you see the HomeBase window shown in the 
next section.

This section...

Using HomeBase

Starting new returns and opening existing returns

Using the Prepare Returns window

Using the menu bar in the Prepare Returns window

Using the Left Navigation Area

Using the Find Forms dialog box

Using Input tabs and Output tabs

Summary of the steps to prepare a client’s returns

Step-by-step instructions to prepare a client’s returns

Entering data on forms, schedule, and worksheets

Finding forms by topic

Using QuickZooms

Preparing more than one copy of a form

Setting up other ProSeries Basic Edition features

Getting information and help

Using the on-screen version of the ProSeries Basic 
Edition Quick Reference Guide

Using ProSeries.com and My ProSeries.com
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Using HomeBase
After you complete the first-time start-up procedures, you see the ProSeries Basic 
Edition HomeBase window. HomeBase summarizes information about your clients 
and client files.

From HomeBase, you start new client files, open existing client files, and perform a 
variety of other tasks involving your client files, such as electronic filing. Note that 
the ProSeries Basic Edition program saves the data for a client’s federal and state 
returns in one client file.

The first time you start the ProSeries Basic Edition program, you see client 
information in HomeBase only if you transferred information from last year’s 
ProSeries client files. As you work on client returns and save client data this year, 
you’ll see information about those clients in HomeBase.

To see information about the clients who meet specific criteria, click the applicable 
HomeBase View tab below the HomeBase toolbar.

Select a 
HomeBase 
View tab to 
see 
information 
about a 
specific set of 
clients.

Create New Client File Open Client File

Search Help field          Live Community panel

Update ProSeries Basic Edition products

Double-click a 
client file to 
open it.

Check here 
for important 
messages.
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With ProSeries Basic Edition software, you start new federal returns and open 
previously-saved federal returns from HomeBase, but you start new state returns and 
open previously-saved state returns from the client’s federal return.

Starting and opening federal returns
You start new federal returns and open previously-saved federal returns from 
HomeBase.

l Start new return. To start the federal return for a client, go to the HomeBase 
toolbar and click the New button.

l Open saved return. To open a previously-saved federal return (including returns 
that were created by the Transfer procedure), double-click the line for that client 
file.

When you start a new federal return or open a previously-saved federal return:

l The program closes HomeBase and opens the Prepare Returns window

l The General Information button is selected in the Left Navigation Area

l The Federal Information Worksheet is open in the Work area

The next illustration shows how the Federal Information Worksheet and the Prepare 
Returns window appear after you click the New button to start a new return.

Select this HomeBase View 
tab To do this

1040 See all clients whose individual return data has been 
saved in a client file. Prepare federal individual returns 
and state individual returns (using the ProSeries Basic 
Edition/State products that are installed).

EF Clients See all returns that have been marked for electronic 
filing, and perform electronic filing tasks.

Bank Product Clients See all returns that have been marked for a bank 
product, and perform bank products tasks.
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The following table explains some of the components of the Prepare Returns 
window:

Componen
t Explanation

Header bar Shows the name of the open client file.

Menu bar Lists the menus that you use to perform various tasks. Click the name of a 
menu to see that menu (below the menu bar). Select commands from the 
menus.

For more information, see Using the menu bar in the Prepare Returns 
window on page 42.

Toolbar Includes buttons to save client data, start new returns, print the current 
form, see a summary of the current return, see a calculator, go to 
HomeBase, go to the HomeBase EF Center, and open the Help Center.

Note that the Back and Next buttons (on the left side of the toolbar) show 
forms in the order that you viewed them.

Input tabs

Step buttons 
in the Left 
Navigation 
Area

Refund or 
Amount Due 
button

Output tabs

Help toolbar

Save client data Go to Help CenterGo to HomeBase

Current data field           Most Common Support QuestionsSearch Help field

Header bar

Menu bar

Toolbar
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Left 
Navigation 
Area

Includes eleven Step buttons and the Refund or Amount Due button.

• Step buttons – Take you step-by-step through the process of preparing 
and filing each client’s federal and state returns.

• Refund or Amount Due – Shows the refund amount or the amount due 
for the open return, based on the data entered. Opens the Tax Summary 
page.

For more information, see Using the Left Navigation Area on page 42.

Input tabs Identifies the forms, schedules, and worksheets for the current federal 
category or current state return on which you want to enter data or have 
entered data. If a form is checked in the Forms checklist for a federal 
category or state return, there’s an Input tab for that form when that federal 
category or state return is selected.

For more information, see Using Input tabs and Output tabs on page 48.

Work area Where a form, schedule, or worksheet appears when you open it.

For more information, see Summary of the steps to prepare a client’s 
returns on page 50 and Step by step instructions to prepare a client’s 
returns on page 54.

Output tabs Identifies the forms, schedules, and worksheets for the current federal 
category or current state return that will be included when you file the 
return electronically or print the return from the Filing Copy tab on the 
Printing page (assuming you haven’t changed the program’s default 
selections in the Filing Copy section of the Printing page).

For more information, see Using Input tabs and Output tabs on page 48.

Help toolbar Includes the following Help features: Field/Form Help, Search Help, and 
Most Common Support Questions.

Tip: To maximize the Help toolbar (from one line to four lines) when a 
return is open, click the Maximize/Minimize control near the upper-right 
corner of the Help toolbar. The Help toolbar will remain maximized until 
it’s minimized.

For more information, see Getting information and help on page 71.

Live 
Community 
panel

Shows questions that have been asked by tax professionals using ProSeries 
software, with questions grouped by whether they have been answered. 
Enables you to ask and answer questions. Provides a quick way to go to 
three useful and informative Web sites.

Status bar Shows the name of the form, schedule, or worksheet that is currently open, 
the type of data field that is currently selected, and the Refund amount or 
Amount Due for the open return, based on the data entered thus far.

To see the status bar at the bottom of the ProSeries Basic Edition window, 
go to the View menu and select Status Bar.

Componen
t Explanation
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Using the Prepare Returns window
From the Prepare Returns window, you can:

l Open forms, schedules, and worksheets

l Enter, edit, and delete data for the current client’s federal and state returns

l Save the current client’s data in a client file

l Check the current client’s return for errors

l Import data from Quicken

l Set up ProSeries Basic Edition options and features

l Set up client-specific billing and view the Client Invoice

l View the Client Filing Instructions letter

l Print the current client’s federal and state returns

l Print specific forms, schedules, and worksheets

l Initiate electronic filing for the current client’s federal and state returns

l Get information and help

Using the menu bar in the Prepare Returns 
window
The following illustration summarizes the menu bar for the Prepare Returns 
window:

Using the Left Navigation Area
The Left Navigation Area has the following:

l Step buttons, which take you step-by-step through preparing a client’s returns

l Refund or Amount Due button, which shows the refund amount or amount due 
for the open federal or state return, and opens the Tax Summary page

Work with 
client files

Edit or 
enter data

Find a form or 
field

Prepare returns 
with the help of 
special tools

Get products 
and product 
updates

Import data 
from Quicken 
data files

Perform electronic 
filing tasks and bank 
products tasks

Go to 
HomeBase

See information 
about the open 
return

Get 
information 
and help

Show or hide 
components of 
the window
42 ProSeries Basic Edition Quick Reference Guide 2009



basic_eug09.book  Page 43  Monday, October 19, 2009  11:37 AM
The Step buttons are discussed next. The Refund or Amount Due button is discussed 
in Using the Refund or Amount Due button on page 47.

Using Step buttons

When a return is open, the Step buttons summarize the steps to prepare the client’s 
federal and state returns.

The first six Step buttons—which are labeled General Information, Income, 
Deductions, Credits, Taxes, and Payments—are for six categories of data for a 
federal return.

Each of these Step buttons include a Forms checklist that lists the forms, schedules, 
and worksheets that are relevant for that category of data.

l When you enter the client’s name, the program adds the name to the General 
Information button.

l As you enter data for the client’s federal return, the program adds the current 
applicable subtotals to the Income, Deductions, Credits, Taxes, and Payments 
buttons. These subtotals are also known as “rolling totals.”

The State button is for state return data. There’s a Forms checklist for each state that 
lists the forms, schedules, and worksheets that are relevant for that state’s returns.

l When you start a state return, the program adds the two-letter abbreviation for 
that state to the State and State Final Review buttons.

l If you prepare more than one state return for a client, the program adds the 
two-letter abbreviation for each state to the State and State Final Review 
buttons. The first state listed is the state return that was most recently open.
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Using Forms checklists

When you select a Step button, you see an Input tab labeled Checklist. Click this tab 
to open the Forms checklist.

You can do the following when a Forms checklist is open:

l Get information. Place the mouse pointer over the name of a form, schedule, or 
worksheet on the Forms checklist to see information about the form, schedule, or 
worksheet in the Field/Form Help area of the Help toolbar (below the checklist).

l Select a form. Click the name of a form, schedule, or worksheet on the Forms 
checklist to select it.

When you select a form, schedule, or worksheet on a Forms checklist, the 
program adds an Input tab for it. (For more information about Input tabs, see 
Using Input tabs and Output tabs on page 48.)

l Open a form. To open a form, schedule, or worksheet, click the associated Input 
tab.

The eleven Step buttons and their purposes are:

Tip: If you remove the check from the box for that form, schedule, or 
worksheet, the program removes the associated Input tab unless:

• There’s client data on the form, schedule, or worksheet, or

• There’s more than one copy of the form, schedule, or 
worksheet

If you attempt to remove the check from a box under these 
circumstances, a dialog box instructs you to open the form that you 
want to remove, then to go to the Forms menu and select the 
Remove command.

Tip: To see a list of all available forms, schedules, and 
worksheets, click the Find Form button on the 
toolbar.
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Use this Step 
button To do this

General 
Information

Enter various information about the client. On the General 
Information Forms checklist, forms are grouped in the following 
categories:

• Client Information, which includes the Federal Information 
Worksheet

• Miscellaneous Tax Forms and Worksheets

• Extensions

• Planning

• State Nonresident and Part-Year Resident

• Electronic Filing and Banking Information

• Preparer and Billing Information

Income Enter information about the client’s income. On the Income 
Forms checklist, forms are grouped in the following categories:

• Wages, which includes the Wage and Tax Statement (Form 
W-2)

• State Tax Refund

• Capital Gains and Losses

• Passthrough K-1s

• Depreciation Summary Reports

• Interest and Dividend Income

• Business, Rental, Farm

• Pension, Annuity, IRA Inc, SS Benefits

• Other Income

• Passive Activity Limitations

Deductions Enter information about the client’s deductions. On the 
Deductions Forms checklist, forms are grouped in the following 
categories:

• Adjustments to Income

• Itemized Deductions

Credits Enter information about the client’s credits. On the Credits Forms 
checklist, forms are grouped in the following categories:

• Earned Income Credit

• General Business Credits

• Other Credit Information

• Child-Related Credits

• Health Insurance Credit
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Taxes Enter information about the client’s taxes. On the Taxes Forms 
checklist, forms are grouped in the following categories:

• Underpayment Penalties

• Tax on Retirement Distributions

• Kiddie Tax

• Tax on Lump-Sum Distributions

• Alternative Minimum Tax

• Household Employment Taxes

• Unreported Social Security/Medicare

• Other Taxes

Payments Enter information about the client’s tax payments. On the 
Payments Forms checklist, forms are grouped in the following 
categories:

• Estimated Tax Payments

• Extension Payments

Federal Final 
Review

Check the open federal return for errors.

State Start a new state return or go to an existing state return.

On the State Forms checklist for California, Illinois, Maryland, 
Massachusetts, Michigan, New Jersey, New York, North Carolina, 
Ohio, and Pennsylvania returns, forms are grouped in the 
categories that are appropriate for that state’s returns.

State Final Review Check the open state return for errors.

Print Print the current client’s federal and state returns.

File Electronically File the current client’s federal and state returns electronically.

Use this Step 
button To do this
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Using the Refund or Amount Due button

Using the Find Forms dialog box
When a return is open, you can use the Find Forms dialog box to open forms, 
schedules, and worksheets. Use any of the following methods to open the Find 
Forms dialog box:

l Go to the toolbar and click the Find Form button  

l Go to the Forms menu and select Find Form

l Press the F6 key, or hold down the CTRL key and press the F key on the 
keyboard

l If a Forms checklist is open, scroll down to the “Can’t find what you are looking 

for?”shaded area, then click the Find Form button  

The Refund or Amount Due button (below the File 
Electronically button in the Left Navigation Area) shows the 
refund amount or amount due for the open federal or state 
return based on the data entered thus far. Click the Refund or 
Amount Due button to open the Tax Summary page. If the 
client’s federal return is open, you’ll see the Tax Summary for 
the federal return. If a state return is open, you’ll see the Tax 
Summary for that state return. There are tabs at the top of the 
Tax Summary page for each of the client’s returns. Select a tab 
to see the corresponding Tax Summary.

This is the Find Forms 
dialog box for federal 
individual returns.

When All Forms is 
selected, you see all 
available forms for 
that type of return.

You can use the Form 
Number or Form 
Description display option.

Select Forms in Use to see 
only the forms containing 
data.

When you type the blue numbers and letters that are 
keyboard shortcuts, they appear here.
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When the All Forms and Display Form Number options are selected, note that:

l Check mark. A check mark precedes a form if:

• It has at least the minimum data required to be considered complete, and

• The ProSeries Basic Edition program doesn’t detect any errors.

l Circle. A circle precedes a form if:

• It’s part of the return, but the ProSeries Basic Edition program detects errors, 
or

• It isn’t part of the return, but it contains data that you (or someone else) 
entered.

To open a form from the Find Forms dialog box:

l Double-click the form, or

l Highlight the form, then click OK or press ENTER

Using Input tabs and Output tabs
As you enter data for a client’s federal or state return, the ProSeries Basic Edition 
program adds Input tabs above the Work area and Output tabs below the Work area.

Using Input tabs

The program adds an Input tab for a form, schedule, or worksheet when you:

l Check the box for a form, schedule, or worksheet on a Forms checklist

l Double-click the name of a form, schedule, or worksheet in the Find Forms 
dialog box

l QuickZoom to a form that didn’t have an Input tab (as explained in Using 
QuickZooms on page 69)

l Click the Create button in a Multiple-Copy Form dialog box (as explained in 
Preparing more than one copy of a form on page 70)

When you’re working on a client’s federal return, there are a separate set of Input tabs 
for the categories of data that correspond to the first six Step buttons in the Left 
Navigation Area. There also are a separate set of Input tabs for each state return.

Tip: To highlight a form, either click the form or use the keyboard 
arrow keys. If the Display Form Number option is selected, you 
also can type the blue letters and/or numbers in the name of the 
form.
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As the program adds Input tabs for a category of federal data or for a state return:

l The tabs become narrower and fewer characters may be visible. If you want to 
see the full name for an Input tab, place your mouse pointer over the tab.

l When the first row is full of Input tabs, the program begins to “stack” the Input 
tabs in a second row.

l When the second row is full of Input tabs, the program begins to “stack” the 
Input tabs in a third row.

l When the third row is full of Input tabs, the program adds a small scroll bar to the 
right side of the Input tab rows so you can scroll through the rows of Input tabs.

Click an Input tab to open the form, schedule, or worksheet that the Input tab 
represents.

Most Input tabs have the name of a form, schedule, or worksheet in black text on a 
gray background. Note the following information about color and Input tabs.

l Red name. The name on an Input tab is red if the program detects that one or 
more data fields on the form, schedule, or worksheet that the Input tab represents 
contain invalid data or are missing required data.

l Green background. The background for the Choose State Input tab is green 
(instead of gray) when the Choose State page is open. The background for the 
Input tab that represents a state return is green when that state return is open.

Using Output tabs

Output tabs identify the forms, schedules, and worksheets that will be:

l Printed as part of the client’s return when you select the Print button while the 
Filing Copy tab is selected at the top of the Printing page (assuming you haven’t 
changed the default selections on the Filing Copy section of the Printing page), 
and

l Filed as part of the client’s return when you file the return electronically.

Exception: The program doesn’t create Output tabs for Explanation statements, even 
though they are filed with returns.

As you work on a client’s federal return, there are a separate set of Output tabs for the 
six categories of data that correspond to the first six Step buttons in the Left 
Navigation Area. However, the first Output tab for each of the six categories of data is 
always the primary signature form (Form 1040, Form 1040A, or Form 1040EZ) for 
the client’s federal return.

Tip: Place the mouse pointer over an Input tab to see the full name 
below the Input tab.
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As you work on a client’s state return, there is one set of Output tabs for that state 
return. If you prepare more than one state return for a client, there is a separate set of 
Output tabs for each state return.

Click an Output tab to open the form, schedule, or worksheet that the Output tab 
represents.

Summary of the steps to prepare a client’s returns
The following table presents a brief summary of the basic steps to prepare client 
returns. For a more detailed explanation of how to prepare a client’s federal and state 
returns, see Step by step instructions to prepare a client’s returns on page 54. Note that 
some optional steps aren’t included in the following table.

Important: Some forms and schedules include Smart Worksheets that help 
you enter data more efficiently. When you open a form by clicking 
an Output tab, the Smart Worksheets on that form (if any) aren’t 
shown. When you open a form by clicking an Input tab, the Smart 
Worksheets on that form (if any) are shown.

To do this Do this

1. Start the client’s 
federal return 
from HomeBase

If you transferred client data from last year’s ProSeries Basic 
Edition (or ProSeries) client file, select the HomeBase View 1040 
tab, then double-click the client’s name to open the client’s file.

If you didn’t transfer client data from last year’s ProSeries Basic 
Edition (or ProSeries) client file, click the New button on the 
HomeBase toolbar.

The Federal Information Worksheet opens.
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2. Prepare the 
client’s federal 
return

a. Import - If there’s relevant client data in a Quicken data file, start 
Quicken, open the Quicken data file, then go to the Import menu in 
ProSeries Basic Edition and select Quicken Import.

b. Enter data - Enter data in the applicable data fields.

Use the General Information, Income, Deductions, Credits, 
Taxes, and Payments buttons in the Left Navigation Area to select 
each category of data.

Use the Forms checklists to add Input tabs for the appropriate 
forms, schedules, and worksheets.

Open a form, schedule, or worksheet by clicking (a) its Input tab or 
(b) an appropriate QuickZoom button or icon.

c. Save the data - Click the Save button on the toolbar often as you 
enter data.

d. Review - Click the Federal Final Review button in the Left 
Navigation Area to correct errors that the ProSeries Basic Edition 
program identifies.

To do this Do this
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3. Prepare the 
client’s state 
return(s)

a. Choose the state(s) - Click the State button in the Left 
Navigation Area, then click the check box for the appropriate 
state(s) on the Choose State page. The program adds an Input tab 
for a state when you select it.

b. Select the state - Click the state Input tab to see the Forms 
checklist for that state. If there’s more than one state Input tab 
(because you selected more than one state on the Choose State 
page), prepare the non-resident state return(s) before the resident 
state return.

c. Enter data - Enter data in the applicable fields on the state forms.

• Use the State Forms checklist to add Input tabs for the 
appropriate forms, schedules, and worksheets.

• Open a form, schedule, or worksheet by clicking (a) its Input tab 
or (b) an appropriate QuickZoom button or icon.

d. Save the data - Click the Save button on the toolbar often as you 
enter data.

e. Review - Click the State Final Review button in the Left 
Navigation Area to correct errors that the ProSeries Basic Edition 
program identifies.

f. Prepare additional state returns - If the client must file any 
additional state returns, take the following steps for each additional 
state return:

• Click the state Input tab for the state. If there isn’t a state Input 
tab for a state, click the Choose State Input tab to open the 
Choose State page, then check the box for the state that you 
want.

• Repeat steps c, d, and e for the state return.

g. Go to federal - Click any of the first six buttons in the Left 
Navigation Area to close the state return and open the client’s 
federal return.

To do this Do this
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4. Print the client’s 
return(s)

a. While the client’s federal return is open, click the Print button in 
the Left Navigation Area to open the Printing page.

b. With the Filing Copy tab selected, review all the information on 
the page, make any adjustments you think are appropriate, then 
click Print.

Caution: If you make adjustments on the Filing Copy page, make 
sure you file all required forms, schedules, and worksheets.

c. Select the Client Copy tab, review all the information on the 
page, make any adjustments you think are appropriate, then click 
Print.

d. Select the Preparer Copy tab, review all the information on the 
page, make any adjustments you think are appropriate, then click 
Print.

5. File the client’s 
return(s) 
electronically

a. While the client’s federal return is open, click the File 
Electronically button in the Left Navigation Area.

b. In the Electronic Filing dialog box, check the box for each of the 
client’s returns that you want to file electronically, then click OK.

c. The program closes the client’s return, opens HomeBase with the 
EF Clients tab selected, then starts the electronic filing process.

d. If the Electronic Filing Transmission dialog box asks “Do you 
want to continue with the convert/transmit process?,” select Yes.

e. If other dialog boxes appear, review the information, then click 
the appropriate button.

6. Check for 
electronic filing 
and bank product 
acknowledgments

a. After 24 to 48 hours, go to HomeBase and click the EF Clients 
tab. Go to the E-File menu and select Check EF and Bank Product 
Acknowledgments.

b. Review the electronic filing acknowledgment information in the 
Check EF and Bank Product Acknowledgments dialog box. Click 
View Acks to see detailed information. Click Print Log to print the 
information.

c. Click the Bank Products Acknowledgments tab (if you’re 
offering bank products through Santa Barbara Bank & Trust), then 
review the bank product acknowledgment information. Click Print 
Log to print the information.

d. Take the steps that are indicated by the acknowledgments you’ve 
received.

To do this Do this
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Step by step instructions to prepare a client’s 
returns
This section presents a detailed explanation of how to prepare a client’s federal and 
state returns. To see a brief summary of the basic steps to prepare client returns, see 
Summary of the steps to prepare a client’s returns on page 50.

Start or open the client’s federal return

Start a new federal return or open the client’s previously-saved federal return from 
HomeBase.

l Start return. Go to the HomeBase toolbar and click the New button.

l Open return. Double-click the line for the client in HomeBase.

The following table summarizes the steps for completing the federal and state returns.

Step 1 - General Information category

Complete all relevant sections of the Federal Information Worksheet.

Enter data in relevant fields with a light beige background.

This step

Step 1 – General Information category

Step 2 – Income category

Step 3 – Deductions category

Step 4 – Credits category

Step 5 – Taxes category

Step 6 – Payments category

Step 7 – Federal Final Review

Step 8 – State returns

Step 9 – State Final Review

Step 10 – Print returns

Step 11 – File the returns electronically

If the General Information button isn’t selected in the Left 
Navigation Area, click it now.
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Note the following about data fields:

l The program changes the background of a field from light beige to light red when 
data that you’ve entered in other fields indicates that data is required for the light 
red field.

l Fields with a white background are calculated by the program based on data that 
you enter.

The Federal Information Worksheet includes the following parts.

Tip: Color descriptions in this guide are for guidance only. On your 
monitor, data fields might have a light yellow or light green 
background rather than a light beige background.

Tip: If you’ve opened a return that was started by the Transfer 
procedure, the Federal Information Worksheet (and other forms, 
schedules, and worksheets) might already contain client data.

Important: The ProSeries Basic Edition program uses the information that you 
enter in the Federal Information Worksheet to prepare the client’s 
federal and state returns.

Part name Comments

Recovery Rebate Credit Information Enter applicable information about an 
economic stimulus payment.

Part I – Personal Information Enter information in the Taxpayer fields. If 
the clients are a married couple, enter 
information in the Spouse fields also.

Part II – Federal Filing Status Check the box for the appropriate filing 
status. Depending on the filing status, you 
might need to enter additional information.

Part III – Dependent/Earned Income 
Credit/Child and Dependent Care Credit 
Information

If necessary, the table expands to 
accommodate the information for all of the 
client’s dependents.

Part IV – Earned Income Credit 
Information

Check the appropriate box for any Earned 
Income Credit situation that applies.

Part V – Return Preparer and Third Party 
Designee Information

Enter your Preparer Code. When applicable, 
select Self-Prepared or Non-Paid Preparer. 
Complete the Third Party Designee section as 
applicable.
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Save the client’s data

After you’ve entered the client’s name and social security number, go to the toolbar 
and click the Save button.

Part VI – Electronic Filing of Tax Return 
Information

If you will be filing the client’s return(s) 
electronically, provide the applicable 
information.

Part VII – Electronic Filing of Extension 
Information

If you will be filing extensions for the client’s 
return(s) electronically, provide the 
applicable information.

Part VIII – Direct Deposit/Electronic 
Funds Withdrawal Information

Complete this section if the client wants 
direct deposit of a federal refund or electronic 
funds withdrawal of a federal balance due.

Part IX – Additional Federal Return 
Information

Select the options in this section that are 
relevant, if any.

Part X – Part-Year and Nonresident State 
Return Filing Information Only

Enter all relevant information. Be sure to 
complete the State Residency Status table if 
applicable.

Part XI – Client Letter Information Enter information that you want the program 
to use on the Client Filing Instructions letter.

Tip: If you aren’t able to complete every section of the Federal 
Information Worksheet now, you can return to the worksheet and 
enter additional information later.

Part name Comments
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In the Save Tax Return dialog box, examine the File name field. By default, the 
program enters the first four letters of the client’s last name and the last four digits of 
the client’s social security number.

If you want to assign a different name to the client file, enter the name that you want 
to use.

When you’re satisfied with the name in the File name field, click the Save button to 
the right of the File name field.

Open the General Information Forms checklist

Click the Checklist Input tab to open General Information Forms checklist.  

Select forms in the General Information Forms checklist

Review the entire General Information Forms checklist, and check the box for each 
form, schedule, and worksheet that you want to prepare for the current client.

When you check the box for a form, schedule, or worksheet, the program adds an 
Input tab for that form, schedule, or worksheet.

Important: When you’re entering data, go to the toolbar and click the Save 
button frequently.

The client’s 
name appears 
here.

The Federal 
Information 
Worksheet box is 
already checked.

Check the box 
for each General 
Information form 
that you want to 
complete.

Output tabs for 
the General 
Information 
category
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Preparing more than one copy of a form, schedule, or worksheet

If you check the box for a form, schedule, or worksheet and there is more than one 
copy available, you’ll see an Add More button after its name.

Click the Add More button if you want to prepare an additional copy of that form, 
schedule, or worksheet. The program will add an Input tab for that copy.  

The Input tabs for each copy of a form, schedule, or worksheet have the same label 
(such as “Form W-2”), but that label is followed by “(Untitled)” until you enter data in 
a specific field on that copy.

For more information about multiple-copy forms, schedules, and worksheets, see 
Preparing more than one copy of a form on page 70.

Enter data on the General Information forms you selected

Enter the applicable data on each form, schedule, or worksheet that you selected in the 
General Information Forms checklist. To open a form, schedule, or worksheet, click 
the Input tab for that form, schedule, or worksheet.

Step 2 - Income category

Review the entire Income Forms checklist, and check the box for each form, 
schedule, and worksheet that you want to prepare for the current client.

Important: If you’ve opened a return that was started by the Transfer 
procedure, there will be a check in the box for the Federal 
Information Worksheet and in the boxes for any other forms, 
schedules, and worksheets that already contain client data.

Important: Enter data in relevant fields with a light beige background. The 
program changes the background of a field from light beige to 
light red when data that you’ve entered in other fields indicate that 
data is required for the light red field. Note that fields with a white 
background are calculated by the program based on data that you 
enter.

When you finish entering data on the General Information 
forms that are relevant for the client, move on to the Income 
category. To do so, click the Income button in the Left 
Navigation Area.
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You’ll probably need to complete at least one copy of the Form W-2 Worksheet for 
most clients. Shown next is a copy of the Form W-2 Worksheet before data has been 
entered.

These Input tabs 
are for the 
Income 
category.

Check the box 
for each Income 
form that you 
want to 
complete.

As you enter 
income data, the 
information on 
this button 
changes.

Output tabs for 
the Income 
category

This is the 
Input tab for the 
Form W-2 
Worksheet.

At the moment, 
Form 1040 is 
the primary 
form.
59



basic_eug09.book  Page 60  Monday, October 19, 2009  11:37 AM
Step 3 - Deductions category

Step 4 - Credits category

Step 5 - Taxes category

Step 6 - Payments category

Step 7 - Federal Final Review

The following table explains each Final Review diagnostic category:

When you finish entering data on the Income forms that are 
relevant for the client, move from the Income category to the 
Deductions category (the way that you moved from the 
General Information category to the Income category), then 
select and complete all the relevant forms in the Deductions 
category.

When you finish entering data on the Deductions forms that are 
relevant for the client, move from the Deductions category to 
the Credits category, then select and complete all the relevant 
forms.

When you finish entering data on the Credits forms that are 
relevant for the client, move from the Credits category to the 
Taxes category, then select and complete all the relevant forms.

When you finish entering data on the Taxes forms that are 
relevant for the client, move from the Taxes category to the 
Payments category, then select and complete all the relevant 
forms.

When you finish entering data for the client’s federal return, 
click the Federal Final Review button in the Left Navigation 
Area.

Final Review 
category Explanation

Errors and Omissions Identifies errors, omissions of required information, estimated 
values, and contradictory information

Electronic Filing Identifies errors that could preclude electronic filing
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The program presents the results of the Final Review process in the Final Review 
window below the Work area.

l Final Review information is grouped by diagnostic category.

l Each category begins with an explanation of that type of diagnostic.

l The program assigns each message one of the following three priority levels:

• You Must Fix This Error

• You Should Fix This Error

• For Your Information

The priority level is shown on the upper-left area of the Final Review window.

l When an error is identified in the Final Review window, the program opens the 
appropriate form and selects the applicable data field, often by placing a red 
border around the field. Correct the error, then click Next.

l Click Next to see the next information in the Final Review window. When you 
click Next, you see either:

• The next error for the current category

• An explanation of the next category

• An explanation that you’ve reached the end of the Final Review process

l The upper-right area of the Final Review window indicates how many errors the 
program detects in the open return. As you resolve errors in the return, the 
number of errors is updated so you know how many errors remain to be 
corrected.

TSJ Tag Errors Searches the return for Taxpayer/Spouse/Joint indicators if you 
change the client’s federal filing status from Married Filing 
Joint to Married Filing Separate

Diagnostics Evaluates the return for required attachments and 
inconsistencies

List of Notes Identifies fields to which you have attached notes

List of Overrides Identifies fields in which you have overridden the calculated 
value

Unsupported 
Calculations

Presents information about calculations the program does not 
perform to help you determine whether there are any items that 
must be manually calculated and entered on the appropriate 
form or schedule in the current return

Deduction Finder Identifies additional deductions and credits for which the client 
might be eligible

Final Review 
category Explanation
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The next illustration shows an error identified by the Final Review Errors and 
Omissions category.

Step 8 - State returns

l If you installed only one state product, the program adds an Input tab for that state 
return and opens the Forms checklist for that state in the Work area.

l If you installed more than one state product, the Choose State page opens. The 
Choose State page lists every state product that’s installed. Check the box for 

Important: When the program informs you “Final Review is complete,” click 
the Recheck button (which appears at the bottom of the Final 
Review area when you reach the end of the Final Review) to make 
sure the client’s return doesn’t contain any new errors.

After the client’s federal return successfully passes Final 
Review, click the State button in the Left Navigation Area if 
the client is required to file one or more state returns.

Important: If the client must file returns for more than one state, be sure to 
open the resident state return after completing the non-resident 
state return(s) so the program can calculate the tax credit offered 
by a resident state on non-resident income.

Click here to see the next information in the 
Final Review window.

Click here to see the previous information 
currently in the Final Review window.

The program 
opens the 
appropriate 
form and 
identifies the 
field.

The program 
often places a 
red border 
around the 
field.

If the 
appropriate 
field isn’t 
selected, click 
here to select 
the field.
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each state return that you need to prepare for the client. When you check the box 
for a state, the program adds an Input tab for that state return.

When you click the Input tab for a state return, the program opens the Forms 
checklist for that state.

l If you need to prepare a return for a state that isn’t installed, click the Add State 
button to open the Product Selections dialog box, select the additional state 
product(s) that you want to install, then click Next.

The next illustration shows the Forms checklist for California.

Tip: If the program detects information from last year’s state return, a 
dialog box asks whether you want to transfer the relevant 
information to this year’s state return.
63



basic_eug09.book  Page 64  Monday, October 19, 2009  11:37 AM
The ProSeries Basic Edition program saves you time by automatically flowing all 
applicable data from the client’s federal return to the client’s state return(s). The Input 
tabs and Output tabs that you see for the client’s state return are derived from the data 
in the client’s federal return.

l Click each Input tab so you can review each state form, schedule, and worksheet. 
Enter any additional information that’s appropriate for the client’s state return.

l Use the state’s Forms checklist to select any additional state forms, schedules, or 
worksheets that are required or appropriate for the client’s state return.

When you complete the client’s state return, click the State Final Review button in 
the Left Navigation Area. See the next section, Step 9 - State Final Review for more 
information.

Step 9 - State Final Review

Note that there are fewer Final Review diagnostic categories for state returns than for 
federal returns.

Use the Final Review window for the client’s state return the same way that you used 
it for the client’s federal return. When the program informs you that you’ve reached 
the end of the Final Review, be sure to click the Recheck button to make sure the 
client’s return doesn’t contain any new errors.

Preparing additional state returns

If the client is required to file more than one state return:

When you finish entering data for the client’s state return, click 
the State Final Review button in the Left Navigation Area.

Input tabs for this 
California return

Forms checklist 
for California

On the State  
button, “CA” 
stands for 
California.

Output tabs for 
this California 
return
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1 Click the State button in the Left Navigation Area, then click the Choose State 
Input tab.

2 Check the box for the state that you want on the Choose State page.

3 Complete the additional state return the same way that you completed the first 
state return, then click the State Final Review button in the Left Navigation 
Area.

4 If the client is required to file state returns for any additional states, repeat Steps 1 
through 3.

5 When you finish preparing the client’s state return(s), click any of the first six 
buttons in the Left Navigation Area to close the state return and open the client’s 
federal return.

Step 10 - Print returns

1 Select the Filing Copy tab, review all the information on the page, make any 
adjustments you think are appropriate, then click Print.

Important: If you prepare more than one state return for a client, be sure each 
state return successfully passes Final Review.

When you want to print a client’s returns, click the Print button 
in the Left Navigation Area to open the Printing page.

Click here to discard changes and 
restore the default settings.

Click here to print the items that 
have a check mark.

Use these four 
tabs to see the 
four sections of 
the Printing 
page.

Check marks 
identify the items 
that are set to be 
printed.

You can add and 
remove check 
marks.

The Printing 
page shows the 
number of pages 
per form and the 
total number of 
pages to print.
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2 Select the Client Copy tab, review all the information on the page, make any 
adjustments you think are appropriate, then click Print.

3 Select the Preparer Copy tab, review all the information on the page, make any 
adjustments you think are appropriate, then click Print.

4 Pay-Per-Return. If you’re printing a state return for a state product that you’re 
using on a pay-per-return basis and you haven’t authorized payment for that state 
return, the Return Authorization dialog box opens so you can authorize 
payment for that state return.

5 The ProSeries Basic Printing Status dialog box keeps you informed.

6 When the ProSeries Basic Printing Message Log dialog box appears. review 
the information, then click the Close button.

7 If you’re going to file the client’s return(s) electronically, see the next section, 
Step 11- File the returns electronically.

Step 11- File the returns electronically

1 In the Electronic Filing dialog box, check the box for each of the client’s returns 
that you want to file electronically, then click OK.

The program closes the client’s return, opens HomeBase with the EF Clients tab 
selected, then starts the electronic filing process.

2 If the Electronic Filing Transmission dialog box asks “Do you want to continue 
with the convert/transmit process?”, click Yes.

Important: A dialog box warns you if you removed the check mark from the 
check box for a required form. Be sure each printed return that you 
file includes all required forms, schedules, worksheets, and other 
items.

Tip: If you want to print a specific form, open that form, then go to the 
toolbar and select the Print button.

When a client’s returns have successfully passed Final Review 
and you’re ready to file them electronically, click the File 
Electronically button in the Left Navigation Area.

As a general rule, each of the 
client’s returns is listed on a 
separate line here.

However, if a state return must be 
filed with the federal return as a 
Fed/State return, the federal return 
and that state return are listed on 
the same line.
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Dialog boxes keep you informed. When the program finishes transmitting the 
return(s), the Electronic Filing Transmission log opens. This log indicates 
whether each return was successfully transmitted and, if returns were not 
successfully transmitted, the reason why they were not successful.

3 Click Print to print the contents of the Electronic Filing Transmission log.

4 Click Close to close the Electronic Filing Transmission log.

For more information about electronic filing, including instructions on how to check 
for electronic filing acknowledgments, see Filing returns electronically on page 77.

For information about bank products, see Overview of Bank Products on page 90.

Entering data on forms, schedules, and 
worksheets
As you select fields on the tax forms, schedules, and worksheets in your clients’ 
returns, you’ll see that fields with a light beige background are available for data 
entry, while fields with a white background are calculated by the ProSeries Basic 
Edition program from data in the client’s returns.

The different kinds of data are represented by different colors.

l Data that you enter is blue.

l Data that the program transfers from the client’s ProSeries Basic Edition client 
file or ProSeries client file from last year is aqua.

l Data that the program transfers from the client’s federal return to a state return is 
aqua.

l Data that the program imported from Quicken is in green.

l Data that the program calculates is black.

l Data from a supporting statement that you created is in purple.

l Data that you’ve marked as estimated is red and in italics.

l Data that the program determines is invalid, such as an invalid social security 
number, is red.

Important: As you enter data, the program changes the background of fields 
that require data (based on the data that you’ve entered in other 
fields) from light beige to light red. You must enter data in fields 
with a light red background.

Important: As you enter data, go to the toolbar and click the Save button 
frequently.
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When you enter data, keep the following in mind:

l After each entry, press ENTER or TAB, or click on a different field.

l When you enter a dollar-and-cents amount or a percentage, include the decimal 
point. The program rounds amounts to the nearest dollar.

l When you enter an amount of more than three digits, the program adds the 
comma.

l When you enter a negative number, type the minus key before the amount.

l If the program shows one or more ways to complete the data entry that you’ve 
begun (because the Use AutoFill option is selected):

• Press ENTER to accept the suggested data if it’s correct, or

• Select the correct alternative from the list of suggested data and press ENTER, 
or

• Continue typing the correct data.

For more information about data entry, use the Search Help feature on the Help 
toolbar or in the Help Center. (For instructions, see Getting information and help on 
page 71.)

Finding forms by topic
The Where Do I Enter? and File Cabinet features can help you determine where to 
enter specific data in a federal return. (These features aren’t available for state 
returns.)

Using the Where Do I Enter? feature

1 Go to Forms menu and select Where Do I Enter? to open the Where Do I 
Enter? dialog box.

Tip: If you prefer, go to the toolbar and click the Where Do I Enter? button.

2 Go to the Search field near the top of the dialog box, then type a keyword or 
keywords that describe the topic in question.

3 Click the line with the applicable entry in the Topic column to go to form, 
schedule, worksheet, or other item that’s identified in the Form column on that 
line.

4 When the form, schedule, or worksheet that’s associated with the topic opens, 
enter the applicable information in the field that’s selected.
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Using the File Cabinet feature

1 Go to the Forms menu, point to Find, then select By topic to open the File 
Cabinet dialog box.

2 Click the applicable File Cabinet drawer for the topic that you want.

3 Go to the field near the top of the dialog box, then type the name of the topic that 
you want so you can view the applicable part of the topic list.

Tip: If you prefer, use the scroll bar to view the applicable part of the topic list.

4 Double-click the name of the topic that you’re interested in.

5 When the form, schedule, or worksheet that’s associated with the topic opens, 
enter the applicable information in the field that’s selected.

Using QuickZooms
Many ProSeries Basic Edition forms include QuickZoom buttons and QuickZoom 
icons.

l Click a QuickZoom button on a form to quickly open a related form and create a 
new Input tab. In most cases, the related form is identified on the line of the form 

with the QuickZoom button.  

l If you see a QuickZoom icon when you select a field on a form, click the 
QuickZoom icon to quickly open a related form and create a new Input tab.  

Important: When you QuickZoom from one form to another in a federal return, you 
might go from one step (or category of forms) to another step (or category of forms). 
When that happens, you’ll see the Input tabs for the current step (or category of 
forms).
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Preparing more than one copy of a form
When applicable, you can prepare more than one copy of some forms. schedules, and 
worksheets. For example, you can prepare more than one copy of the Form W-2 
Worksheet or Schedule C for federal returns.

If you use a Forms checklist to create a new copy of a multiple-copy form, schedule, 
or worksheet, the program adds an Input tab for that copy above the Work area.

l That Input tab identifies the form, schedule, or worksheet and includes 
“(Untitled)”.

l When you enter a name in the appropriate field on the form, schedule, or 
worksheet, the program replaces “(Untitled)” with the name that you entered.

For example, if you enter “ABC Corporation” in the Employer’s Name field of a 
Form W-2 Worksheet, the program replaces “(Untitled)” on the Input tab with 
“ABC Corporation”.

If you click a QuickZoom button or QuickZoom icon to go to a form, schedule, or 
worksheet for which you can prepare more than one copy, you’ll see the 
Multiple-Copy Form dialog box for that form.

l To open an existing copy of the form, schedule, or worksheet, click Select an 
existing <form> to open, then double-click the name of the copy that you want.

The program opens the copy of the form, schedule, or worksheet.

l To open a new copy of the form, schedule, or worksheet, click Create new copy, 
enter a name for the new copy, then click the Create button.

The program opens a new copy of the form, schedule, or worksheet, creates an 
Input tab for the new copy (with the name you provided), and enters the name 
you provided in the appropriate field on the form, schedule, or worksheet.

For more information about forms navigation, use the Search Help feature on the 
Help toolbar or in the Help Center.
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Setting up other ProSeries Basic Edition features
Use the information in the following table to set up the following ProSeries Basic 
Edition features.

For more information about ProSeries Basic Edition features, use the Search Help 
feature. (The Search Help feature is discussed in the next section.)

Getting information and help
The ProSeries Basic Edition Help system includes a Help toolbar near the bottom of 
the HomeBase window and the Prepare Returns window with three features to help 
you get the information that you need quickly and easily. Those features are:

l Search Help

l Most Common Support Questions

l Field/Form Help

Tip: The Search Help feature is discussed in Getting information and 
help on page 71.

To do this Do this

Internet. Set up an Internet connection so you can 
use ProSeries Basic Edition connectivity features.

Go to the Help menu and select 
Internet Connection Setup.

Product licensing. License your ProSeries Basic 
Edition tax products so you can print and file 
returns electronically.

Go to the Tools menu, select 
License Products, then select 
Online or Manual. (We 
recommend that you select Online.)

Pay-Per-Return. Add funds to a pay-per-return 
account so you can print and file returns 
electronically (for products you’re using on a 
pay-per-return basis).

Go to the Tools menu, select Pay 
Per Return, then select Increase 
Account Balance.

Slip sheets. Select options for slip sheets to use 
with envelopes and presentation folders.

Go to the Tools menu and select 
Global Slip Sheet Options.

Billing rates. Set billing rates for the forms, 
schedules, and worksheets of a specific type of 
return.

After you open a return of the 
applicable type, go to the Tools 
menu, select Billing, then select 
Billing Rates Per Form.
71



basic_eug09.book  Page 72  Monday, October 19, 2009  11:37 AM
These three information and help features are discussed later in this section.

For information about a specific ProSeries Basic Edition tax product:

l See the product Release Notes that accompanied the ProSeries Basic Edition CD, 
or

l Click the Help button  on the toolbar, select ReadMe Information in the 
Help Center, then select the ProSeries Basic Edition tax product, or

l Start a new return or open a previously-saved return for that ProSeries Basic 
Edition tax product, then:

• Click the Help button   on the toolbar, then select What’s New This 
Year? in the Help Center, or

• Go to the Search Help field on the Help toolbar or in the Help Center, type 
keywords or a question in the Search Help field, then click the iSEEK button.

The next illustration shows the Federal Information Worksheet and the Help toolbar 
features in the Prepare Returns window.

Tip: To change the vertical size of the Help toolbar when a return is 
open, click the Maximize/Minimize control near the upper-right 
corner of the Help toolbar.

Field/Form HelpSearch Help Most Common Support Questions

To change 
the height 
of the Help 
toolbar, 
click here.
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Search Help

To get answers to a question or information about a keyword or phrase, type the 
question, word, or phrase in the Search Help field, then press the ENTER key or 
click the iSEEK button next to the Search Help field.

The program searches ProSeries Basic Edition Help content, then lists the search 
results in the Help Center. Click the blue, underlined title of a search result to see the 
full content of that information source in the Help Center or a browser window.

Most Common Support Questions

Most Common Support Questions are top support topics that are linked to 
information in ProSeries Basic Edition Help. Click a question to see the relevant 
information in the Help Center.

Field/Form Help

When you’re working on a return in the Prepare Returns window, the left area of the 
Help toolbar shows some information about the currently-selected field or form. 
Click the blue, underlined word “more” to see all the current Field/Form Help 
information in the Help Center.

Field/Form Help includes Tax Help, Cross-References, and Government Instructions.

Using the Live Community feature

You can use the Live Community pamel on the right side of the ProSeries Basic 
Edition window to interact with tax professionals. The following are among the 
things you can do:

l Read questions asked by others and review the corresponding answers, if any

l Ask questions and receive answers from others

l Answer questions asked by others

Using the Help Center

All three features in the Help toolbar—Search Help, Most Common Support 
Questions, and Field/Form Help—open the Help Center. From the Help Center, you 
can get a variety of information quickly from one, easy-to-use location.

Important: Asking and answering questions requires an Intuit Online 
Account.
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The Help Center is divided into the following four sections:

l Tax Return Help — Provides information about the open tax return

- Includes the Tax Help, Government Instructions, Cross Reference, and 
TaxAlmanac selections

l ProSeries Help — Provides information about using the ProSeries Basic 
Ed5ition program,

- Includes the User’s Guide and Program Help selections

l Technical Support — Provides important product information

- Includes the Quick Answers, Email Technical Support, and ReadMe 
Information selections

l ProSeries.com — Is a resource for online help tools and information

- Includes the My ProSeries and Search Online Help selections

Tip: The Help Center opens when you click the Help button on 
the toolbar.

Search for a specific topic in 
Help here.

Click the selections on the left 
side of the Help Center to see 
the corresponding information 
to the right.

Click here to provide feedback that will help 
us improve the help content.

Click here to see the previous information.

Click and drag the splitter bar to 
adjust the window sizes.

Click here to close the Help Center.

Click a plus sign [+] to expand 
a selection.
Click a minus sign [-] to 
collapse a selection.

Use the scroll bars to see all the 
information in the Help Center.

Click blue, underlined 
hyperlinks to see more about 
those topics.
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For more information about ProSeries Basic Edition Help, use the Search Help 
feature on the Help toolbar or in the Help Center to find the information that you 
want.

Using the on-screen version of the ProSeries Basic 
Edition Quick Reference Guide
The on-screen version of this ProSeries Basic Edition Quick Reference Guide is 
automatically installed on your system. You can use the Search Help feature to find 
information in the guide.

To open the ProSeries Basic Edition Quick Reference Guide from the Help Center:

1 Go to the left side of the Help Center and click User’s Guide.

2 The ProSeries Basic Edition Quick Reference Guide title page and Table of 
Contents appear in the ProSeries Basic Edition Quick Reference Guide browser 
window.

3 Click a topic in the Table of Contents, or click the Index or Search tab.

When the ProSeries Basic Edition Quick Reference Guide is open in the browser 
window:

l Click a topic in the Table of Contents to see that information in the display area to 
the right of the Table of Contents.

l Use the scroll bars to see all the information in the Table of Contents and the 
display area.

l Click blue, underlined words and phrases to see more information about those 
topics.

l Click the Printer icon in the upper-right corner of the browser window to print 
the current topic.

l Click the Index and Search tabs to use those Quick Reference Guide features.

Using ProSeries.com and MyProSeries
ProSeries.com (http://www.proseries.com) includes up-to-date information about 
ProSeries Basic Edition products and services.

Tip: To minimize the Quick Reference Guide to the Windows taskbar 
while you work in the ProSeries Basic Edition program, click the 
Minimize control box at the upper-right corner of the browser 
dialog box. To see the Quick Reference Guide again, click 
ProSeries Basic User’s Guide on the Windows taskbar.
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MyProSeries is a section of www.proseries.com provides content that’s customized 
for you, such as:

l A way to complete product licensing manually

l Technical Support answers to current support issues

l Chat support with a ProSeries Basic Edition technical support agent

l E-mail support with historical logs of your e-mail correspondence

l Links to various helpful Web sites

Important: You must set up an account to use MyProseries so we can provide 
you with information specific to your ProSeries Basic Edition 
products.

Tip: For information about ways to learn more about using ProSeries 
Basic Edition software, go to http://www.proseries.com and select 
Training.
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Filing returns electronically
ProSeries Basic Edition electronic filing software is installed with ProSeries Basic 
Edition tax products that support electronic filing.

ProSeries Basic Edition software supports electronic filing of the following:

l Federal individual returns and extension request forms

l State individual returns (for 41 states and the District of Columbia) and 
extensions (for Massachusetts and New York returns)

l Minnesota property tax refund returns

IRS Web site. To visit the e-file Providers area of the IRS Web site, go to http://
www.irs.gov, select Tax Professionals, then select e-file Providers. If you prefer, 
you can go directly to http://www.irs.gov/taxpros/providers/index.html.

For detailed information about electronic filing:

l Go to http://www.proseries.com and select E-File Resources at the bottom of the 
screen, or

l Use the Search Help feature on the Help toolbar or in the Help Center.

Establishing an Internet connection

To file electronically, you need to connect to the Internet from the computer on which 
the ProSeries Basic Edition program is installed.

If you don’t have an Internet connection, you must first sign up for service with an 
Internet Service Provider (ISP). Once you have an ISP, go to the Help menu, select 
Internet Connection Setup, then follow the instructions in the dialog boxes.

Important: PINs required. The IRS requires that tax practitioners e-file 
individual income tax returns with Practitioner PINs or taxpayer 
Self-Select PINs. Tax practitioners can’t submit a paper signature 
for e-filed returns using Form 8453. The redesigned Form 8453 
will be used only to transmit required supporting paper documents.

Important: You must have a valid EFIN. If you don’t have an IRS-issued 
Electronic Filing Identification Number (EFIN) yet, see Preparing 
for electronic filing on page 4.
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Setting up the ProSeries Basic Edition program for 
electronic filing

If you’ve already entered your electronic filing information, proceed to Step 1 - 
Mark the return for electronic filing on page 79.

If you haven’t entered your electronic filing information yet, take the following 
steps to set up the ProSeries Basic Edition electronic filing options.

1 Go to the Help menu and select Options Setup Wizard.

2 EFINs. In the Firm/Preparer Information dialog box, enter the firm’s 
Electronic Filing Identification Number (EFIN) in the Firm Information 
section, and enter preparers’ Electronic Filing Identification Numbers (EFINs) in 
the Preparer/Electronic Return Originator (ERO) Information section. After 
you enter an EFIN, complete the corresponding Efile Contact Name fields.

PINs. PINs (Personal Identification Numbers) are used as electronic signatures. 
Enter each preparer’s PIN in the ERO Practitioner PIN field. A Practitioner PIN 
is any five-digit code (except all zeros) chosen by each preparer.

3 In the Filing Client Returns Electronically dialog box, select Yes, some 
returns may be filed electronically.

4 Complete the remainder of the Options Setup Wizard.

If more than one computer will be using the same EFIN

When ProSeries Basic Edition software is installed on a computer, the DCN 
(Declaration Control Number) counter is set at “00001.” The program assigns that 
number to the first federal return that’s marked for electronic filing, then increments 
the DCN counter by “1.” As each subsequent federal return is marked for electronic 
filing, the program assigns the current DCN to that return, then increments the DCN 
counter by “1.”

Enter the firm’s EFIN and an e-file 
contact name here.

Enter a preparer’s PIN here.

Enter a preparer’s EFIN here.

If you enter an EFIN, enter ERO 
contact information here.
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To change the starting number in the DCN counter for a computer:

1 Go to the Tools menu, then select Options.

2 Select Electronic Filing in the left side of the Options dialog box.

3 Go to the DCN Counter field and increase the number.

Step 1 - Mark the return for electronic filing

1 Open the client’s federal return, go to the Federal Information Worksheet, scroll 
down to Part V - Return Preparer and Third Party Designee, then make sure 
the appropriate preparer code is entered in the Preparer Code field.

2 In Part VI - Electronic Filing of Tax Return Information, make sure the File 
federal return electronically box is checked.

Important: If your firm will be filing returns electronically from more than 
one computer, and each computer is using the same EFIN, change 
the starting number in the DCN counter in the program on all but 
one computer before preparers start to transfer or prepare returns. 
By advancing the DCN counter sufficiently in the program on each 
“additional” computer, each return marked for electronic filing 
will be assigned a unique DCN. For example, advance the DCN 
counter to “01001” on the second computer, to “02001” on the 
third computer, and so on.

Tip: If a computer will be using a unique EFIN, it’s not necessary to 
change the starting number in the DCN counter for that computer.

Tip: If you’re acting as an ERO and filing a return for another preparer, 
enter that preparer’s preparer code in the Preparer Code field.
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3 State returns. If you’re going to file the client’s state return(s) electronically, 
make sure the File state return electronically box is checked and select the 
appropriate state return(s) in the State(s) table.

Note the following about the three EF filing types for state individual returns.

4 DCN information. Note that the program assigns a DCN to the client’s return(s).

PIN Information. Complete the appropriate fields in the Practitioner PIN 
Program section.

QuickZooms. When applicable, use the QuickZoom buttons near the end of Part 
VI to go directly to the apporpriate worksheet(s) and/or statement.

EF filing 
type States Comments

Independent California, 
Illinois, Maine, 
Massachusetts, 
and Minnesota

Independent EF filing type state returns don’t 
have to be electronically filed with the 
corresponding federal return. Returns for these 
states are electronically filed directly with the 
state taxing authority.

Fed/State Hawaii Fed/State EF filing type state returns must be 
electronically filed with the corresponding federal 
return. Returns for Hawaii are electronically filed 
to the IRS, then sent to the state taxing authority.

Fed/State or 
State-Only

36 states that 
aren’t an 
Independent state 
or a Fed/State 
state

Fed/State or State-Only EF filing type state 
returns don’t have to be electronically filed with 
the corresponding federal return. Returns for 
these states are electronically filed to the IRS, 
then sent to the state taxing authority.

Check this box to 
file the federal 
return 
electronically.

Check this box to 
file the state 
return(s) 
electronically.

Select the state 
return(s) for 
electronic filing 
in this table.

See Help if you 
need assistance.
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5 Direct Deposit/Direct Debit. If the client wants their refund deposited directly 
into their account or the balance due withdrawn from their account, complete 
Part VIII - Direct Deposit/Electronic Funds Withdrawal Information.

Step 2 - Prepare the client’s return(s) for electronic filing

1 Complete the client’s federal return.

2 Complete the Electronic Filing Smart Worksheets on the client’s Form W-2, 
1099-R, W2-G, and 1099-G worksheets (if applicable).

3 RAL or RT. If you’re offering Bank Products through Santa Barbara Bank & 
Trust and the client wants a Refund Anticipation Loan or Refund Transfer, 
complete the applicable parts of the Bank Product Information Worksheet.

For more information, see Overview of Bank Products on page 90.

4 Click the State button in the Left Navigation Area.  

5 Complete the client’s state return.

6 Click the General Information button in the Left Navigation Area.  

7 Go to the toolbar and click the Save button.  

Tip: See Avoiding common reasons for rejection after Step 7.

Check this box 
to use direct 
deposit of any 
federal refund.

Check this box 
to use electronic 
funds 
withdrawal of a 
federal balance 
due.

Be sure to 
complete the 
rest of Part VIII.
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Avoiding common reasons for rejection

l Verify the client’s social security number (SSN) and Date of Birth (DOB) with 
the Social Security Administration (SSA).

l If you’re preparing a Married Filing Joint return, verify that the spouse’s last 
name on the return matches the spouse’s last name on his or her Social Security 
card.

l Make sure the employer’s name and federal identification number on the actual 
Form W-2 match the information you’ve entered in the ProSeries Basic Edition 
program.

l Make sure the payer’s name and federal identification number on the actual Form 
W-2G or Form 1099-R match the information you’ve entered in the ProSeries 
Basic Edition program.

l Use error-checking during data entry. To do so, open a return, then go to the View 
menu and make sure there’s a check mark before Error Alerts.

Step 3 - Run Final Review from the client’s return

After you complete a federal or state return, run the ProSeries Basic Edition Final 
Review to help you check the return for errors.

1 To review the open federal return, click the Federal Final Review button in the 
Left Navigation Area.

To review the open state return, click the State Final Review button in the Left 
Navigation Area. 

2 Analyze the Final Review report, and fix all errors that are identified.

3 Click Recheck to check the return for errors.

4 Go to the IRS e-file Authentication Statement in the client’s federal return, make 
sure the box at the top of the form is checked, then complete the remainder of the 
form.

For more information, click the Help button    while the IRS e-file 

Authentication Statement is open on the screen.

Take similar steps for the client’s state return(s), if applicable.

5 Print Form 8879, IRS e-file Signature Authorization, in the client’s return, then 
instruct the taxpayer (and spouse if applicable) to sign and date the form.
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6 Review the federal return and any state returns (including forms concerning 
electronic filing and bank products) with the client before proceeding.

7 If you determine that the client must submit printed copies of specific documents 
after the client’s federal return has been accepted by the IRS, review Form 8453 
in the client’s federal return. Also review any corresponding electronic filing 
paperwork forms in the client’s state return(s), if applicable.

Step 4 - From the EF Clients view, select the return(s)

You can select a client’s return(s) for electronic filing from the client’s open return or 
from the HomeBase EF Clients view.

Selecting returns from the client’s open return
1 Click the File Electronically button in the Left Navigation Area.

2 In the Electronic Filing dialog box, check the box for each of the client’s returns 
that you want to file electronically.

3 Click OK.

The program closes the client’s return, opens HomeBase with the EF Clients tab 
selected, then starts the electronic filing process.

4 Proceed to Transmitting returns that were selected from the client’s open return 
on page 85.

Selecting returns from the HomeBase EF Client’s view
1 If HomeBase is on the screen, click the EF Clients tab below the toolbar. If a 

client’s return is on the screen, go to the toolbar and click the EF Clients button.  

Important: You are required to keep a signed and dated copy of Form 8879, 
IRS e-file Signature Authorization, for three years.

Important: The IRS revised Form 8453 before the 2007 tax year.
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The HomeBase EF Clients view presents important information about each client 
return that you’ve prepared and marked for electronic filing, including the status 
of each return.

2 Select the client’s returns that you want to file electronically. Their status should 
be Return Marked for EF or Return Ready to Transmit.

State returns. State returns are listed after the client’s federal return. Select a 
client’s federal and state returns at the same time. To select more than one return, 
hold down the CTRL key while you click each return that you want to file 
electronically.

3 Proceed to Transmitting returns that were selected from the HomeBase EF 
Clients view below.

Tip: If you select returns for more than one client, the program instructs 
you to select the return(s) for only one client.

Tip: While California, Illinois, Maine, Massachusetts, and Minnesota 
returns do not need to be electronically filed with the 
corresponding federal return, it’s best to do so. If a North Dakota 
or South Carolina return isn’t filed with the corresponding federal 
return, that state return can’t be electronically filed until the 
federal return is accepted.

The status should be Return Marked for EF or Return Ready to Transmit.

This client’s 
federal and 
state returns 
are selected 
for electronic 
filing.
84 ProSeries Basic Edition Quick Reference Guide 2009



basic_eug09.book  Page 85  Monday, October 19, 2009  11:37 AM
Step 5 - Convert and transmit the selected return(s)

You can convert and transmit a client’s return(s) from the client’s open return or from 
the HomeBase EF Clients view.

Transmitting returns that were selected from the client’s open 
return

If you selected a client’s return(s) for electronic filing from the client’s open return (as 
explained in Selecting returns from the client’s open return on page 83), take the 
following steps:

1 If the Electronic Filing Transmission dialog box asks “Do you want to continue 
with the convert/transmit process?”, select Yes.

2 Dialog boxes keep you informed. When the program finishes transmitting the 
return(s), the Electronic Filing Transmission log opens. This log indicates 
whether each return was successfully transmitted and, if returns were not 
successfully transmitted, the reason why they were not successful.

3 Click Print to print the contents of the Electronic Filing Transmission log.

4 Click Close to close the Electronic Filing Transmission log.

Transmitting returns that were selected from the HomeBase EF 
Clients view

If you selected a client’s return(s) for electronic filing from the HomeBase EF Clients 
view (as explained in Selecting returns from the HomeBase EF Client’s view on page 
83), take the following steps:

1 Go to the E-File menu, select Electronic Filing, then select Convert/Transmit 
Returns and Extensions.

2 If any informational dialog boxes appear, read the information, then click OK.

3 If you see a Pay-Per-Return dialog box, authorize payment for the indicated 
client files.

4 In the Electronic Filing Options dialog box, select Convert and Transmit 
selected returns/extensions.
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5 Make sure the Enable conversion error checking box is selected.

6 Check the Receive Acknowledgments for all EFINs box if more than one EFIN 
was entered in the Firm/Preparer Information section of the Options dialog 
box and you want to receive electronic filing acknowledgments for all EFINs (not 
just the EFIN associated with the return that’s being electronically filed now). 

7 Click OK.

When the ProSeries Basic Edition program finishes converting and transmitting the 
returns, the Transmit Electronic Filing Returns/Extensions Log opens so you can 
review the results.

Step 6 - Wait 24 to 48 hours, then check for 
acknowledgments

To check for acknowledgments from the IRS or state taxing authorities:

1 Go to the HomeBase EF Center. If HomeBase is on the screen, click the EF 
Clients tab below the toolbar. If a return is on the screen, go to the toolbar and 

click the EF Center button.  

Tip: A return that cannot pass error checking will usually get rejected 
by the IRS. Therefore, do not disable conversion error checking 
unless directed to do so by a ProSeries Basic Edition Technical 
Support Representative.

Important: The ProSeries Basic Edition program automatically checks for 
acknowledgments when you transmit client returns. It may take 
more than 48 hours to receive an acknowledgment for some 
federal and state returns.

Make sure there’s a check 
in this box.
86 ProSeries Basic Edition Quick Reference Guide 2009



basic_eug09.book  Page 87  Monday, October 19, 2009  11:37 AM
2 Select the client’s return in the EF Center, click the right mouse button, then 
select View Electronic Filing Status History to open the client’s Electronic 
Filing Client Status History for that federal or state return.

3 Review the Electronic Filing Client Status History and identify the most recent 
status of the client’s return, then click Close.

4 If the most recent status of the return is “Return Accepted,” proceed to Step 7 - 
Complete the electronic filing process on page 88.

If the most recent status of the return is “Return Rejected,” proceed to Resolving 
a problem with a rejected return on page 87.

If the most recent status of the return isn’t “Return Accepted” or “Return 
Rejected,” continue with Step 5.

5 Go to the E-File menu and point to Electronic Filing.

6 From the Electronic Filing menu, select Receive Acknowledgment Statuses to 
get the latest acknowledgments.

7 In the Receive Electronic Filing Acknowledgments Log, click View Acks to 
see the detailed Acknowledgment Report.

If there aren’t any acknowledgments, View Acks is not available. In most cases, 
you will receive a client’s federal acknowledgment before you receive the client’s 
state acknowledgment.

8 Review the information, then click Close. If the return was rejected, continue 
with Resolving a problem with a rejected return next.

Resolving a problem with a rejected return
1 Go to the HomeBase EF Center.

• If HomeBase is on the screen, click the EF Clients tab below the toolbar.

Tip: There’s a separate Electronic Filing Client Status History for each 
federal and state return. Open the Electronic Filing Client Status 
History for each return.

Tip: If a client’s return was rejected, the report shows why it was 
rejected, and how to fix the error.
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• If a return is on the screen, go to the toolbar and click the EF Center button.  

2 Go to the E-File menu, point to Electronic Filing, select Electronic Filing 
Reports, then print a Rejected Returns report.

3 Incorrect SSN. If a return was rejected because the taxpayer’s social security 
number wasn’t correct, print the Intuit Electronic Postmark Report before 
correcting the social security number and resubmitting the return. This provides 
the original date and time of filing.

4 Fix the errors in the rejected return.

5 Make sure the corrected return passes Final Review.

6 Convert and retransmit the corrected returns as explained in Step 4 - From the EF 
Clients view, select the return(s) on page 83 and Step 5 - Convert and transmit the 
selected return(s) on page 85.

Re-filing state returns. If you’ve filed a client’s federal and state returns 
together and the federal return is accepted but the state return is rejected, in most 
cases you can re-file the corrected state return electronically.

Step 7 - Complete the electronic filing process

Federal return. After you receive an acknowledgment that the IRS has accepted a 
client’s federal return, take these steps:

1 Form 8453. If the client is required to file additional documents with the IRS, 
print Form 8453, U.S. Individual Income Tax Transmittal for an IRS e-file 
Return, attach the required paper documents to Form 8453, then mail Form 8453 
and the attached documents to the appropriate IRS service center within the 
applicable time period.

Tip: The Preparing Form 8453 section of the Electronic Filing 
Information Worksheet identifies the paper documents to attach to 
the client’s Form 8453.

Tip: The Additional Information Smart Worksheet on Form 8453 
shows the address to which the client’s Form 8453 should be 
mailed.
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2 Print Form 9325. Print Form 9325, Acknowledgment and General Information 
for Taxpayers Who File Returns Electronically, if you want to give the form to 
the client.

To print Form 9325:

1. Open the client’s federal return.

2. Click the General Information button, then click the Form 9325 Input 
tab to open Form 9325.

3. Go to the File menu and click the Print button.

4. Click Close to close the ProSeries Basic Printing Message Log.

3 Balance due. If the client’s federal return has a balance due and the client did not 
elect to have their bank account directly debited, print Form 1040-V, Balance 
Due Payment Voucher and give it to your client.

State returns. After you receive an acknowledgment that the state taxing authority 
has accepted a client’s individual return, take these steps:

1 Mail the completed state electronic filing paperwork to the appropriate state 
service center within the time period required by the appropriate taxing authority 
(if the state taxing authority requires electronic filing paperwork).

2 Balance due. If the client owes state taxes, follow the state instructions. You’ll 
probably need to give the client a printed copy of a completed state tax payment 
voucher along with appropriate instructions.

3 Getting current information. To review common reject reasons, 
troubleshooting information, and frequently-asked questions from http://
www.proseries.com, do either of the following:

• While in the ProSeries Basic Edition HomeBase EF Clients view, go to the 
Steps to E-File section, then click the Search Online for EF Answers button. 

Tip: The use of Form 9325 is optional, but you do need to retain a 
completed copy of Form 8879, IRS e-file Signature Authorization, 
that’s been signed by the client. You might need to retain a 
completed copy of state electronic filing paperwork also.

Important: If your client owes federal taxes, he or she must mail Form 1040-V 
and the payment to the IRS by the filing deadline.

Tip: You might need to retain a completed copy of state electronic 
filing paperwork.
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• While in your Internet browser, go to http://www.proseries.com, select 
Products, then select E-File Resources at the bottom of the page.

For more information about electronic filing, use the Search Help feature on the Help 
toolbar or in the Help Center.

Overview of Bank Products
When you file your clients’ federal individual returns electronically, those clients may 
be eligible to receive proceeds based on their expected federal refunds in the form of 
bank products such as:

l Refund Anticipation Loans (RALs),

l Refund Anticipation Loan Direct Deposits (RALDDs),

l Refund Transfers (RTs), and

l Refund Transfer Direct Deposits (RTDDs)

In addition, your fees can be deducted from the client’s refund and deposited into your 
bank account electronically.

As a general rule, a client is eligible for a bank product if:

l The client is due a federal refund, and

l You’re filing the client’s federal return electronically

ProSeries Basic Edition bank products software through Santa Barbara Bank & Trust 
is included with ProSeries Basic Edition and integrates with ProSeries Basic Edition 
electronic filing software. However, you can offer bank products through Refund 
Advantage instead of Santa Barbara Bank & Trust.

Note the following:

Tip: IRS refund cycle. For information about the IRS refund cycle, go 
to the IRS Web site at http://www.irs.gov.

Tip: You can offer Refund Transfers and Refund Transfer Direct 
Deposits based on the expected state refund from one state under 
certain circumstances if you’re offering bank products through 
Santa Barbara Bank & Trust.

Tip: For more information about offering bank products through Santa 
Barbara Bank & Trust or Refund Advantage, go to http://
www.proseries.com, select Products, then search for Bank 
Products.
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l If you’re accepted by Santa Barbara Bank & Trust, your clients’ RAL and RT 
applications are sent to Santa Barbara Bank & Trust when you electronically file 
their returns with the IRS.

l If you’re accepted by Refund Advantage, you use the software you receive from 
Refund Advantage to send your clients’ RAL and RT applications to Refund 
Advantage when the IRS accepts the clients’ electronically-filed returns.

The following table shows the names and acronyms that each bank uses for bank 
products.

The following table summarizes the basic steps for offering bank products to your 
clients through Santa Barbara Bank & Trust:

Important: You can offer bank products through only one bank for the current 
tax year.

Bank
Refund 
Anticipation 
Loan

Refund 
Anticipation 
Loan Direct 
Deposit

Refund 
Transfer 
Check

Refund 
Transfer 
Direct Deposit

Santa 
Barbara 
Bank & 
Trust

RAL RALDD RT RTDD

Refund 
Advantage

RAL Not applicable Electronic 
Refund Check 
(ERC)

Electronic 
Refund Deposit 
(ERD)

To take this step Do this

1. Set the ProSeries Basic 
Edition Bank Products 
options.

a. Go to the Tools menu, select Options, then select Bank 
Products.

b. Select the Bank Products options that you want.

c. Click Enrollment/Registration Information, then enter 
the requested information in the Bank Products Registration 
Information dialog box and click OK.

2. Transmit your 
registration information to 
Santa Barbara Bank & 
Trust (any time after 12:00 
a.m. PST on December 1).

a. Click the Bank Products tab in HomeBase.

b. Go to the E-File menu, point to Bank Products, then select 
Transmit Enrollment/Registration Information.
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3. Check for the 
registration acceptance 
status from Santa Barbara 
Bank & Trust.

a. Click the Bank Products tab in HomeBase.

b. Go to the E-File menu, select Go to Bank Products, then 
select Check EF & Bank Product Acknowledgements. The 
acknowledgements log provides information about the status 
of your registration and enrollment with SBBT. 

c. Contact SBBT if you have any questions about the status 
provided. You will receive an activation letter from SBBT 3 
to 5 days after your enrollment record has been activated.

Note: Until SBBT approves your enrollment record, it 
remains in a Pending status. You cannot process returns 
containing bank products until your enrollment is approved.

5. Receive activation letter a. Your activation letter includes a copy of your financial 
services agreement and a PIN that you can use to gain access 
to the Santa Barbara Bank & Trust Web-based Client 
Information Support Center (CISC) at https://
cisc.sbbtral.com/index.asp. From this Web site, you can 
download forms and order a variety of reports that will help 
you keep track of your business. You can also check on the 
status of a taxpayer's RT or RAL transaction. 

b. Once your enrollment is activated, SBBT will set up a 
shipping record. The supplies you requested via your 
enrollment application will be shipped to you automatically 
during the last two weeks of December. Additional supplies 
can be ordered any time during the season by calling SBBT at 
(800) 779-7228 or by visiting https://cisc.sbbtral.com/
index.asp. 

Note: All supplies are shipped Airborne Ground, unless it is 
the week before the electronic filing season begins - then they 
will be shipped overnight.

6. Prepare the client’s 
federal return for a bank 
product.

a. Prepare the client’s federal and state return(s).

b. Prepare the client’s federal return and state return(s), if 
applicable, for electronic filing.

c. Complete the Bank Product Information Worksheet in the 
client’s federal return.

d. Review the client’s return(s) and make sure the return(s) 
successfully pass Final Review.

e. Print the Refund Anticipation Loan (RAL) and Refund 
Transfer (RT) Application and Agreement form from the 
client’s federal return, and have the taxpayer(s) sign it.

7. File the client’s return(s) 
electronically.

a. Click the EF Clients tab in HomeBase and select the 
client’s return(s).

b. Go to the E-File menu, select Electronic Filing, then select 
Convert/Transmit Returns and Extensions.

To take this step Do this
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l RAL check amounts. Refund Anticipation Loans are limited to $7,500.

l RT check amounts. There’s a limit of $5,500 per Refund Transfer check.

For additional details about bank products, use the Search Help feature on the Help 
toolbar or in the Help Center.

8. Receive bank product 
print authorizations and 
status messages (after the 
electronic filing status for 
the client’s federal return 
and/or state return 
becomes “Return 
Accepted”).

a. Click the Bank Products tab in HomeBase.

b. Go to the E-File menu, select Bank Products, then select 
Check EF & Bank Product Acknowledgements.

9. Print the client’s Refund 
Anticipation Loan or 
Refund Transfer check(s). 
(This step isn’t applicable 
for direct deposits.)

a. If “Ready to Print” appears in the Status column of the 
HomeBase Bank Products view, select the client.

b. Go to the E-File menu, select Bank Products, then select 
Print Checks...

c. Deliver the check(s) to the client.

10. If there’s a problem 
with a check, resolve the 
problem.

a. Click the HomeBase View Bank Products tab and select 
the client whose check is affected.

b. Go to the E-File menu, select Bank Products, then select 
Resolve Check Problems...

11. View or print Bank 
Products reports.

a. Click the Bank Products tab in HomeBase and select the 
client returns that you want to include in the report.

b. Go to the E-File menu, select Bank Products, then select 
Reports.

Important: Note the following about RAL and RT check amounts.

Tip: If a client’s refund is greater than $7,500 and less than $10,000, the 
amount axceeding $7,500 is distributed as an RT check (up to a 
maximum of $2,499).

Tip: There’s no limit to the total amount that can be distributed to a 
client via multiple Refund Transfer checks. However, none of the 
checks can exceed $5,500.

To take this step Do this
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anti-spyware software 10
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applying to IRS for an EFIN (Electronic Filing Identification Number) 4
audit report, pay-per-return 9
authorizing payment for pay-per-return processing 9, 66, 85
AutoFill option 68
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getting ready 5
Options Setup Wizard 23
overview 90
preparing for 5
RALDDs 90, 91
RALs 81, 90, 91, 93
Refund Advantage 5, 90
Refund Anticipation Loan Direct Deposits 90, 91
Refund Anticipation Loans 81, 90, 91, 93
Refund Transfer Direct Deposits 90, 91
Refund Transfers 81, 90, 91, 93
RTDDs 90, 91
RTs 81, 90, 91, 93
Santa Barbara Bank and Trust 5, 90
Step 1 - Apply to bank 91
Step 10 - View or print reports 93
Step 2 - Set bank products options 91
Step 3 - Transmit registration information 92
Step 4 - Check for registration acceptance 92
1



basic_eug09.book  Page 2  Monday, October 19, 2009  11:37 AM
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Step 6 - File returns electronically 92
Step 7 - Receive print authorizations and status messages 92
Step 8 - Print checks 92
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Basic Edition
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installing 13
License Agreement 4
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product licensing 31
program 1
system recommendations 2
system requirements 2
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BASWIN directory 15
bill by form 71
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Add More 58
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File Electronically 46
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C
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CD, ProSeries Basic Edition 6, 13, 36
CDs, ProSeries Basic Edition 35
charger per form 71
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bank product print authorizations 92
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errors 42, 60, 64
product updates, Options Setup Wizard 24

check pay-per-return account balance 9
Checklist tab 44
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customer information 20
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Internet connection 19
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product licensing 19
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starting 19, 20

connectivity, Internet 9
contents of the user’s guide 1
converting data

non-Intuit software 11
ProSeries 27
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Cross-References 74
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converting data from non-Intuit software 11
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AutoFill option 68
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editing 42
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data entry
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data files
non-Intuit software 11
opening 38
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dollars-and-cents amounts 68
E
Earned Income Credit information 55
Edit menu 42
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E-File menu 42
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acknowledgments 86
avoiding rejections 82
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common reasons for rejection 82
DCNs 78
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Electronic Filing Information Worksheet 88
Electronic Filing Options dialog box 85
Electronic Filing Transmission Log 85
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Form 9325 89
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Step 2 - Prepare the returns 81
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Step 4 - Select the returns 83
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Step 7 - Complete the process 88
Transmit Electronic Filing Returns/Extensions Log 86
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Errors and Omissions, Final Review 60
estimated data 67
extension, electronic filing 56
extension, federal 77
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extension, New York 77
F
features, setting up 42, 71
Federal Final Review category 60
Federal Final Review Step button 46
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electronic filing 79
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56
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complete the process 88
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overview 77
prepare the returns 81
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filing instructions 55
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Final Review

categories 60
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Electronic Filing 60
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state return 64
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Connected Customer Wizard 19
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Form 1040 product 1, 13, 39
Form 8453, electronic filing 88
Form W-2 data 59
Form W-2 Worksheet 59
forms

finding by topic 68
multiple copy 58, 69
opening 42, 44
printing 42, 66
QuickZooming 69
removing 44

Forms checklist 44, 57, 58
Forms menu 42
forms, finding 47
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General Information category 54, 60
General Information Forms checklist 57
General Information Step button 45
getting help 42, 71
getting information 42, 71
getting ready

bank products 5
bank products information 9
computer system 9
electronic filing 4
electronic filing information 9
firm and preparer information 9
overview 1
ProSeries Basic Edition 6
providing setup information 9
tax season 3

getting started
electronic filing 78
10 ProSeries Basic Edition Quick Reference Guide 2007



basic_eug09.book  Page 11  Monday, October 19, 2009  11:37 AM
installing ProSeries Basic Edition software 13
preparing computer system 9
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Government Instructions 74
guide, user’s 75
H
hard disk space, computer 3
Header bar 40
Help

Cross-References 74
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Government Instructions 74
Help button 74
Help Center 73
Live Community feature 73
Live Community panel 41
menu 42
Most Common Support Questions 73
My ProSeries 74, 75
Program Help 74
ProSeries.com 75
Quick Answers 74
ReadMe Information 72, 74
Release Dates 74
Search 73
Tax Help 74
toolbar 41, 71
User’s Guide 74, 75
What’s New This Year? 72

Help button 74
Help Center 73
Help menu 42
Help toolbar 41, 71
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HomeBase 38, 71
HomeBase 1040 view 39
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HomeBase menu 42
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Income Forms checklist 58
Income Step button 45
increasing pay-per-return account balance 9
Information menu 42
information, getting 42, 71
Input tabs 41, 48
installing

products 15
ProSeries Basic Edition software 13
selecting products 15
state products 15, 26
troubleshooting suggestions 18

instructions, client filing 42
Internet

browser 17
connection 3, 19, 71, 77
connectivity 9
Internet Service Provider (ISP) 3, 77
updating products 35

Internet browser, computer 3
Internet Explorer 17
introduction 1
Intuit packing slip 6, 13
invalid data 67
invoice, client 42
IRS e-file Authentication Statement 82
IRS Web site 90
IRS Web site, electronic filing 77
IRS-issued Electronic Filing Identification Number (EFIN) 4
itemized deductions 56
K
key, ENTER 68
key, TAB 68
Keyboard Shortcuts
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Command keys 11
Function keys 12

knowledge, computer system 3
L
large amounts 68
last year’s data, transferring 27
launching ProSeries Basic Edition 17
Left Navigation Area

General Information button 39
overview 42
Refund or Amount Due button 47
Step buttons 43
summary 41

letter, Client Filing Instructions 42
License Agreement, ProSeries Basic Edition 4, 14
licensing products 31
licensing software 4, 31
licensing, product information 6
licensing, selecting state products 26
light beige data fields 54, 67
light red data fields 55, 67
limits, product licensing 8
List of Notes, Final Review 61
List of Overrides, Final Review 61
Live Community feature 73
Live Community panel 41
M
main form selection 56
Manual method of product licensing 31
manually entered data 67
Massachusetts extensions 77
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menu
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File 42
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Help 42
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Import 42
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View 42

menu bar, Prepare Returns window 40, 42
Menu Summary

Client Data 6
HomeBase 1

minimum requirements, system 2, 14
Minnesota property tax refund returns, electronic filing 77
Most Common Support Questions 73
Multiple-Copy Form dialog box 70
multiple-copy forms 58, 69
My ProSeries 74, 75
N
name and address, firm 4, 24, 31
negative numbers 68
new products, Connected Customer Wizard 19
New York extensions 77
no limit license 6
non-Intuit data 11
non-Intuit last year data 27
notes, product release 72
O
Online method of product licensing 31
Open Forms dialog box 47
opening

existing client file 38, 39
existing return 38, 39
federal return 54
forms, schedules, worksheets 42, 44
state return 62

options
electronic filing 78
Options Setup Wizard 23
prior-year 22, 23
setting 22, 42
transferring last year’s from ProSeries 22, 23

Options Setup Wizard
bank products 23
check for EF acknowledgments 23
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check for product updates 24
e-file electronic signature PINs 23
filing client returns electronically 23
firm and preparer information 23, 24
print a test page 24
select a printer 24
starting 23
using 23

ordering
presentation folders 6
supplies 6
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Output tabs 41, 48, 49
P
packing slip 6, 13, 20
payment for pay-per-return processing 9
Payments category 60
Payments Step button 46
pay-per-return

adding funds to account 8, 71
authorizing payment 9, 66, 85
checking funds in account 9
increasing account balance 9
increasing funds in account 9
printing audit report 9
usage 8
viewing audit report 9

per form billing 71
percentages 68
performance, computer 10
personal information 55
PIN for electronic filing 26
PINs

electronic filing 23, 78, 80
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Prepare Returns window 39

components 40
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Live Community panel 41
menu bar 40, 42
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Toolbar 40
using 42
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preparer
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EFIN 24
information, Options Setup Wizard 23
name, printing 26
self-employed 26

preparer code
entering 25, 55, 79
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self-prepared return 25
setting up 25
using 25

preparer information 9, 24
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preparer, firm’s 4
preparing
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bank products 5
computer system 9
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electronic filing information 9
federal returns 6, 54
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print a test page, Options Setup Wizard 24
Print returns category 65
Print Step button 46
printer, computer 3
printing

pay-per-return audit report 9
preparer name 26
Printing page 65
returns 65
specific forms 66
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processor, computer 2
product licensing

100-return limit license 7, 31
50-return limit license 31
Connected Customer Wizard 19
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information 6
Manual method 31
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Online method 31
overview 31
setting up 71
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product updates, Connected Customer Wizard 19
products
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ReadMe Information 74
Tax Return Help 74
updating from CD 36
updating via Internet 35

Program Help 74
ProSeries Basic Edition

bank products 90
CDs 6, 13, 35
client files 38
components 2
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Connected Customer Wizard 19, 20
Customer Service 10, 11, 32
data files 38
desktop icon 17, 18
electronic filing 77
Form 1040 product 13
getting help 42, 71
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tax software 1
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Refund Transfers (RTs) 5, 90, 91
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